Legal notices

Contents

Introduction
What's new in Lightroom CC ................................................................. 1
Lightroom CC system requirements ...................................................... 12
Lightroom CC | Common questions ....................................................... 15
Creative Cloud Photography plans | Common questions .......................... 17
Add photos .............................................................................. 22
Edit photos .............................................................................. 25
Organize photos ....................................................................... 48
Save or share your photos ................................................................. 55
Migrate photos and videos from Lightroom Classic CC to Lightroom CC ................................................................. 61
Set preferences ........................................................................ 66
Adobe Photoshop Lightroom CC for mobile and Apple TV | FAQ ................................. 70
Feature summary | Lightroom CC | 2018 releases ........................................ 77
Migrate Apple Photos Library to Lightroom CC .................................. 132
Feature summary | Lightroom CC | 2019 releases ........................................ 138
Find and organize photos of people in the People View ........................ 149
Introduction

What's new in Lightroom CC

The October 2018 releases of Lightroom CC desktop (version 2.0), Lightroom CC for mobile (version 4.0), and Lightroom CC for web (lightroom.adobe.com) roll out several new features and enhancements that enrich your digital imaging experience. Read on for a quick introduction to these features and links to resources offering more information.

Note:

With the new Auto-update feature, your Creative Cloud apps are now automatically upgraded whenever a new version is available. For Lightroom CC, you cannot have two versions of the app running simultaneously on your computer. Your existing app preferences and settings are migrated to the latest version. You can manage the update preferences using the Creative Cloud desktop app. Learn more.

Lightroom CC (desktop)

People view

Powered by Adobe Sensei

Find photos of specific people faster now that Lightroom CC uses Adobe Sensei technology to automatically sort your photos based on who's in them. When you upload and sync photos to the cloud, Lightroom CC detects, recognizes, and groups photos of the same person.

To navigate to the People View, click the My Photos icon at the upper-left side of the screen and click People.

For detailed information, see Find and organize photos of people in the People View.
Migrate Apple Photos (Mac only)
You can now easily migrate your Apple Photos Library into Lightroom CC on your desktop. Your photos sync to the cloud so you can access, edit, organize, and share them on all your devices.

For detailed instructions, see Migrate Apple Photos Library to Lightroom CC.

Easily share your photos to the web
In addition to sharing albums, you can now share any random selection of photos as a web gallery.

To share a selection of photos, do the following:

1. Select photos that you want to share from the grid view or the filmstrip.
2. Right-click (Win) / Control+click (Mac) over your selection and select Share to Web from the context menu.
3. In the Share Settings dialog box that appears, a unique link is generated. You can use this link to share your selected photos. Edit the name of the set of photos being shared under the Title option and specify the sharing Preferences.
4. Click Continue. Your set of selected photos is now public.

To view the list of all photos or photo galleries that are public, click the Sharing icon to bring up the Sharing panel. Under Shared to Web, click Photos to find all your public photos and photo galleries as a drop-down list.

For detailed information, see Share photos as a web gallery.

Adobe Portfolio integration
Showcase your photos on the web now that you can send them directly to Adobe Portfolio from Lightroom on your desktop.
For detailed information, see Share to Adobe Portfolio.

**Improved search**

**Powered by Adobe Sensei**

Start typing in the search bar, and Lightroom CC automatically offers suggestions to help you quickly find what you need. Search for cameras, locations, and other metadata with ease. Also, your enabled filters are kept neatly organized in the search box. You can even search for a filter using its name (try ‘camera’).

For related information, see Search, filter, and sort photos.

**Local color toning**

You can now apply colors to specific areas of your photo with the **Brush** and **Gradient** tools.
When using the Brush, Linear Gradient, or Radial Gradient tools in Lightroom CC, scroll down to the bottom of the adjustment sliders panel to turn on Color.

(Illustrative example) Changing the color of irises (eyes) using the Brush tool.

To learn how to use the Brush and Gradient tools to enhance different parts of a photo, see the following tutorials:

- Make selective edits

- Improve a portrait

HEVC file support on macOS

Beginning with this release, Lightroom CC supports Apple’s HEVC video format (High Efficiency Video Coding, also known as H.265) on macOS High Sierra (10.13) or later.

For more information, see HEVC video files support.

Support for new cameras and lenses

For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models

- Supported lens profiles

Lightroom CC for mobile (iOS and Android)

People view

Quickly find the people you care about with the Adobe Sensei-powered People View. Lightroom CC automatically tags people in photos and provides you with an easy way to see all of the photos that person appears in.
People view in Lightroom mobile for iOS recognizes and groups photos of the same person in a cluster.
People view in Lightroom mobile for Android recognizes and groups photos of the same person in a cluster.

For more details, see these Help resources:

- People view (iOS)
- People view (Android)

Search Improvements

Now search suggestions are presented as you start typing in the Search bar, recommending things like cameras, lenses, shutter speeds, apertures, ISOs, keywords, locations, and more.
Intuitive autocomplete suggestions when using Search in Lightroom CC for mobile (iOS)

Intuitive autocomplete suggestions when using Search in Lightroom CC for mobile (Android)
For more details, see these Help resources:

- Search photos (iOS)
- Search photos (Android)

**Additional sharing options for Share to Web**

You can now choose to only share images that are flagged or with a certain star rating or higher, while controlling the display theme and appearance, directly from within Lightroom CC app.

*Display options when you share your collection on web in Lightroom CC for mobile (iOS)*
Introduction

Display options when you share your collection on web in Lightroom CC for mobile (Android)

For more details, see these Help resources:

- Share web gallery (iOS)
- Share web albums (Android)

**New guided tutorials**
The following new guided tutorials have been introduced in this release:

- (iOS) First-Time Adjustments and Healing Brush
- (Android) First-Time Adjustments, Target Adjustment Tool, and Guided Upright
New guided tutorials under Help & Support in Lightroom CC for mobile (iOS)
Support for new cameras and lenses
For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles

Other enhancements
- Improved high-ISO rendering: Raw processing has been further improved to render low-light, high-ISO shots with more natural color.
- (Android only) Improved quality of HDR captures.

Lightroom CC for web (lightroom.adobe.com)
The new Display view within lightroom.adobe.com lets you see a preview of the page, exactly how your viewers will see it. While in the Display view, you can control the layout and background color while inserting breaks between images and text to help tell the story that accompanies your photos. When you're done setting up the layout, you can then share the album using the controls under Sharing.
Lightroom CC system requirements

Applicable for  October 2018 (2.0) release

System requirements for earlier releases  Lightroom CC system requirements | earlier releases

Note:

• To install and use Lightroom CC, you need Windows 10 (v1709 or later) or, macOS 10.12 or later. Lightroom CC is not supported on Windows 7, Windows 8.x, Windows 10 (v1511 and v1607), or macOS 10.11 (El Capitan).

• Running Windows 7 with Service Pack 1 (64-bit) on your computer? Consider using Lightroom Classic CC instead. Check the system requirements or learn more.

Upgrade your operating system

Minimum system requirements for Lightroom CC
## Introduction

### Windows

<table>
<thead>
<tr>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor</strong></td>
</tr>
<tr>
<td>Intel® or AMD processor with 64-bit support; 2 GHz or faster processor</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
</tr>
<tr>
<td>Microsoft Windows 10* with 64-bit support (Version 1709 or later)</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
</tr>
<tr>
<td>4 GB of RAM (8 GB recommended)</td>
</tr>
<tr>
<td><strong>Hard disk space</strong></td>
</tr>
<tr>
<td>2 GB of available hard-disk space for program installation</td>
</tr>
<tr>
<td><strong>Monitor resolution</strong></td>
</tr>
<tr>
<td>1024 x 768 display</td>
</tr>
<tr>
<td><strong>Graphics processor acceleration requirements</strong></td>
</tr>
<tr>
<td>• AMD: Radeon GPU with DirectX 12 or OpenGL 3.3 support.</td>
</tr>
<tr>
<td>• Intel: Skylake or newer GPU with DirectX 12 support.</td>
</tr>
<tr>
<td>• NVIDIA: GPU with DirectX 12 or OpenGL 3.3 support.</td>
</tr>
<tr>
<td>• OpenGL 3.3 and DirectX 10-capable video adapter for GPU-related functionality.</td>
</tr>
<tr>
<td>• 1 GB Video RAM (VRAM). 2 GB of dedicated VRAM (4 GB recommended) for large, high-resolution monitors, such as 4K- and 5K-resolution monitors.</td>
</tr>
<tr>
<td><strong>Internet</strong></td>
</tr>
<tr>
<td>Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.†</td>
</tr>
</tbody>
</table>

* Not supported on Windows 10 version 1511 and 1607.

† NOTE: Internet connection, Adobe ID, and acceptance of license agreement required to activate and use this product. This product may integrate with or allow access to certain Adobe or third-party hosted online services. Adobe services are available only to users 13 and older and require agreement to additional terms of use and the Adobe Privacy Policy. Applications and services may not be available in all countries or languages and may be subject to change or discontinuation without notice. Additional fees or membership charges may apply.

### macOS

<table>
<thead>
<tr>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor</strong></td>
</tr>
<tr>
<td>Multicore Intel processor with 64-bit support</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
</tr>
<tr>
<td>macOS v10.12 (Sierra), macOS v10.13 (High Sierra), or macOS v10.14 (Mojave)</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
</tr>
<tr>
<td>4 GB of RAM (8 GB recommended)</td>
</tr>
</tbody>
</table>
### Language versions available for Lightroom CC

Adobe Photoshop Lightroom CC is available in the following languages:

- Deutsch
- Dutch
- English
- Español
- Français
- Italiano
- Português (Brasil)
- Svenska
- ???
- ???
- ???
- ???
Lightroom CC | Common questions

Basics

• What is Lightroom CC?
  Lightroom CC is a new photography service by Adobe that includes desktop, mobile, and web apps. Lightroom CC automatically backs up all your photographs to the cloud and lets you access and work with your photos from any desktop or mobile device.

  Lightroom CC provides you the editing power of Lightroom Classic CC and Adobe Camera Raw in one easy-to-use package. In Lightroom CC, you experience seamless workflows across devices. The editing and organization tools it offers are similar to the ones you already use on your mobile, desktop, and on the web.

  Lightroom CC is designed to work seamlessly with Lightroom CC for mobile (iOS), Lightroom CC for mobile (Android), Lightroom CC on the web, and Lightroom CC for Apple TV.

• How is Lightroom CC different from Lightroom Classic CC?
  While Lightroom CC and Lightroom Classic CC differ in several ways, there are three main things that separate them:

  • Lightroom CC on Mac and Windows share a similar and consistent experience with other Lightroom CC apps on mobile and web.

  • Lightroom CC uploads all your full resolution original photos to the cloud. This means that all your photos are safely backed up. It also means that Lightroom CC can do various things that Lightroom Classic can’t. For example, you can use Lightroom CC to access all your photos on multiple computers such as a laptop and a desktop, or a home computer, and a work computer.

  • Lightroom CC also provides features that are based in the cloud, such as the ability to search for photos based on what’s in the photo — without having to add any keywords manually. For example, you can search for ‘dog’ to find photos of dogs in Lightroom CC without having to manually assign the keyword ‘dog’ to any photos.

  For related information, see Go from Lightroom Classic to Lightroom CC.

• What’s going to happen to Lightroom Classic CC? Will Adobe release a new version of Lightroom Classic CC?
  Adobe will continue to develop Lightroom Classic CC alongside Lightroom CC.

• Can I use Lightroom CC and Lightroom Classic CC together?
  Yes. To sync between Lightroom CC and Lightroom Classic, you must use Lightroom Classic version 7.0 or later.

  Any photos that you’ve synced from Lightroom Classic are available in Lightroom CC as a Smart Preview. If you import photos into Lightroom CC, the full resolution originals of your photos sync back to Lightroom Classic.

• Does Lightroom CC work with Adobe Photoshop? Third-party plug-ins?
  Yes; Lightroom CC has an ‘Edit in Photoshop’ feature. Lightroom CC doesn’t currently support third-party plug-ins.

• Can I go back to using Lightroom Classic CC if I don’t like Lightroom CC?
  Yes, all the work you have in Lightroom CC (except for keywords) automatically syncs back to Lightroom Classic CC. To enable this feature, launch Lightroom Classic CC and ensure that sync is enabled.

• Is Lightroom CC available in Creative Cloud Team and Enterprise plans?
  Yes, Lightroom CC is available in Creative Cloud Team and Enterprise plans.
Technical questions

• What are the minimum system requirements to run Lightroom CC? Does Lightroom CC use my graphics processor?
  For details, see the Lightroom CC system requirements page and the Lightroom GPU FAQ.

• Does Lightroom CC support raw files?
  Yes; Lightroom CC supports all the raw file types that Lightroom Classic CC and Adobe Camera Raw support. To see the full list, visit Cameras supported by Camera Raw.
  Your original, full resolution raw files are backed up in the cloud.

• Does Lightroom CC support High Efficiency Image File (HEIF) files?
  See this tech note for information on HEIC image files support.

• Can I have multiple catalogs in Lightroom CC?
  No. Your Adobe ID is the key to all your photos stored in the photo cloud.

• Where are my photos stored? Can I keep them locally on my computer?
  LinkLightroom CC manages your photos for you, so that your photos don't fill up your hard drive space. This allows you to keep and work with many photos, even if there's not enough room for all the photos on your hard drive.
  You can always view all your photos in Lightroom CC, even if the original file is not stored on your hard drive. When you are working with a photo and the original is not already present on your computer, Lightroom CC automatically downloads it from the cloud.
  Lightroom CC also provides the option to always keep all your original files on the computer's hard drive as well, in addition to backing them up to the cloud. If you'd like to keep certain images available locally, do the following:

  1 In Square Grid view, click the Sync icon at the lower-right corner of the image thumbnail.

  2 In the pop-up menu that appears, switch on the Store Original Locally option.
  Within the Local Storage preferences, you have the option of changing how much of your available disk space is usable by Lightroom CC. By setting the Target Available Disk Space Usage slider to the desired amount, you can choose how much or how little of your hard disk space Lightroom CC is allowed to use.

• How much cloud storage does Lightroom CC provide? Can I upgrade my storage?
  The amount of cloud storage depends on your Creative Cloud membership. You can check the available space by going to the Account tab of the Preferences dialog in Lightroom CC.
  For more information about upgrading your storage, see Upgrade your Creative Cloud storage.
Can I sync just some of my photos to the cloud?
No; Lightroom CC safely backs up all your photos to the cloud.

How do I retrieve my photos after my membership ends?
You can use the Adobe Lightroom Downloader app to download your photos from Creative Cloud after your membership expires.

Download
The downloads page on adobe.com says that I’m not eligible to download this app. Why is that the case?
First, make sure that you are signed in with your Adobe ID on adobe.com before trying to download.

Creative Cloud Photography plans | Common questions

General questions
What are the Creative Cloud Photography offerings?
Adobe photography plans offer the perfect solutions for editing, organizing, storing, and sharing images for anyone interested in photography—from photo enthusiasts to professionals.

The Lightroom CC plan includes Lightroom CC with 1TB of photo cloud storage. It's the ideal option for photographers who want to access and edit their photography anywhere.

The Creative Cloud Photography plan includes Lightroom CC with 20GB of photo cloud storage, Lightroom Classic CC, and Photoshop CC. It's ideal option for photographers who want to access their photography anywhere and want the transformative power of Photoshop CC.

The Creative Cloud Photography plan with 1TB includes Lightroom CC with 1TB of photo cloud storage, Lightroom Classic CC, and Photoshop CC. It's the ideal option for anyone who wants to take full advantage of cloud storage in addition to everything offered in the Creative Cloud Photography plan.

What does the Creative Cloud photography plan include?
The Creative Cloud Photography plan includes the following apps:

- Adobe Photoshop CC
- Adobe Photoshop Lightroom CC on desktop, mobile, and the web
- Adobe Photoshop Lightroom Classic CC
- Adobe Portfolio
- Adobe Spark with premium features
- Adobe Bridge
- 20 GB cloud storage

You get all the essential tools to organize, edit, and share your photographs from anywhere—on your computer, on the web, and on your iOS or Android device. Master new skills with an extensive library of how-to videos and always have access to the latest imaging innovation from Adobe. Learn more about the Creative Cloud Photography plan.

What does the Creative Cloud Photography plan with 1 TB include?
The Creative Cloud Photography plan with 1 TB includes the following apps:

- Adobe Photoshop CC
- Adobe Photoshop Lightroom CC on desktop, mobile, and the web
- Adobe Photoshop Lightroom Classic CC
- Adobe Portfolio
- Adobe Spark with premium features
- Adobe Bridge
- 1 TB cloud storage

You get all the essential tools to organize, edit, and share your photographs from anywhere—on your computer, on the web, and on your iOS or Android device. Master new skills with an extensive library of how-to videos and always have access to the latest imaging innovation from Adobe. Learn more about the Creative Cloud Photography plan with 1 TB.

**What is the new Lightroom CC?**

Lightroom CC is a brand-new photo service. It’s the cloud-based version of Lightroom that works across desktop, mobile, and web. The all-new Lightroom CC automatically stores full-resolution photos to the cloud when you import them from desktop, mobile, or the web. Edits are automatically reflected on all your devices.

**What are the key differences between Lightroom CC and Lightroom Classic CC?**

Lightroom CC is cloud-based photo so you can work across desktop, mobile and web. Lightroom Classic CC is the desktop-focused photography product.

<table>
<thead>
<tr>
<th></th>
<th>Lightroom Classic</th>
<th>Lightroom CC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where you like to work on your photography?</td>
<td>Desktop only</td>
<td>Desktop, mobile, and web</td>
</tr>
<tr>
<td>Location of originals</td>
<td>Local hard drive</td>
<td>Cloud</td>
</tr>
<tr>
<td>File backup</td>
<td>Not provided</td>
<td>Automatic</td>
</tr>
<tr>
<td>Ease of use</td>
<td>Most comprehensive</td>
<td>Intuitive, streamlined</td>
</tr>
<tr>
<td>Organization and finding photos</td>
<td>Manual keywords</td>
<td>Automatic tagging and intelligent search</td>
</tr>
</tbody>
</table>

Read more about the differences between Lightroom CC and Lightroom Classic here.

**Did the name of the previous desktop version of Lightroom change?**

Lightroom Classic is the renamed version of the Lightroom app you have used in the past, and it is optimized for desktop-focused workflows, including local storage of your photos in files and folders on your computer. The interface, import and organize functionality, and the editing feature set is much the same as before. We are continuing to invest in Lightroom Classic.

**I am a Creative Cloud Photography plan member. How do I upgrade to the Photography plan with 1 TB?**

You can upgrade your plan here. When you're nearing the storage limit for your current Creative Cloud Photography plan, you're also prompted within Lightroom CC to upgrade your plan and get more storage.

**Are the applications installed on my computer or are they cloud based?**

Your Creative Cloud desktop applications (such as Lightroom CC and Photoshop CC) are installed locally on your computer. You don't need an ongoing Internet connection to use them. You only need to connect to the Internet once every 99 days to validate your membership.
However, an ongoing internet connection makes your Lightroom CC experience much richer. For example, you need an internet connection to back up your images to the cloud and have them available on all your devices. You also need an internet connection to use the search feature in Lightroom CC.

- **Do my photos need to be stored in the cloud?**

  Lightroom CC, included in the Creative Cloud Photography plans, safely backs up all your photos to the cloud. Lightroom CC manages your photos for you, so that your photos don't fill up your hard drive space. This storage management allows you to keep and work with many photos, even if there's not enough room for all those photos on your hard drive.

  You can always view and work with all your photos in Lightroom CC, even if the original file is not stored on your hard drive. When you begin working with that photo, the original file is automatically downloaded from cloud storage. Lightroom CC provides you the option to always keep all your original files on the computer's hard drive, in addition to backing them up to the cloud.

  If you'd prefer to not store your images in the cloud, you can use Lightroom Classic CC.

- **What happens to my photos if I end my membership?**

  **Lightroom CC:** Adobe will continue to store your original images for one year after your membership lapses. During that time, you can continue to launch Lightroom CC to download your original files from our cloud services.

  **Lightroom Classic CC:** You'll still have access to all your photos on your local hard drive through Lightroom for the desktop. You can continue to import and organize photos as well as output your edited photos through Export, Publish, Print, Web, or Slideshow. Access to the Develop & Map modules and Lightroom for mobile are not available after your membership ends.

- **Are my images stored securely in the cloud?**

  Yes; your photos are stored securely and safely using Adobe's cloud services infrastructure.

- **Can I delete my images that are stored in the ecosystem?**

  When you delete photos from Lightroom CC on desktop, mobile, or web, they are removed from Adobe's services and all the synced devices. Currently, this operation is not recoverable. However, the deleted photos are still available in the synced Lightroom Classic CC catalog stored locally on your computer and aren't removed from the hard disk.

- **I am a Creative Cloud Photography plan customer. Will my plan cost more?**

  Your Creative Cloud Photography plan stays at the same price. If you want to upgrade to the Photography plan with 1 TB, you can do so through an exclusive offer. See [Change your Creative Cloud plan](#).

- **Can I switch to the Creative Cloud Photography plan from the Creative Cloud Photography plan with 1 TB?**

  Yes; you may switch to the Creative Cloud Photography plan if you want to do so.

- **Is the all-new Lightroom CC available in Creative Cloud Team and Enterprise plans?**

  Yes, Lightroom CC is available in Creative Cloud Team and Enterprise plans.
If you subscribed to the Creative Cloud Photography plan before October 18, 2017, refer to the frequently-asked questions below:

- **I subscribed to the Photography plan prior to 10/18/2017. What is changing in my plan?**
  
  Your plan still includes Photoshop CC and the same Lightroom desktop app (now named Lightroom Classic CC), and you pay the same price: $9.99 per month. Your plan now includes an additional app—the all new Lightroom CC and 20GB of cloud storage.
  
  - The version of Lightroom that you have been using is now called Lightroom Classic CC to reflect its more traditional desktop-centric use case. Lightroom Classic CC has significant performance improvements and several new editing features. No features or functionality have been removed from Lightroom Classic CC.
  
  - Photoshop CC is updated with several new editing features; see the [New features summary](#).
  
  - Additionally, your plan now includes the new Lightroom CC app across desktop, mobile, and the web along with 20GB of cloud services, so you can get a feel of the new Lightroom CC.

- **Why did you change the name of the Lightroom I am used to?**
  
  We are excited about the new Lightroom CC and see it as the future of photography—a complete photo service that provides anywhere access and easy editing of full resolution photos, worry-free backups and effortless organization, but also has the editing power for someone like you.
  
  That said, some customers prefer local storage of their photos and are used to the existing Lightroom user interface. So, we wanted to keep that experience available for those who want it. We used the term “Classic” to indicate that this version is optimized for the more traditional way of working, with the desktop as the center of the experience. Lightroom Classic CC was improved on October 18, 2017 with significant performance improvements and editing features and will be updated on an ongoing basis in the future.

- **I want to stick with the Lightroom I’m used to. How do I do that?**
  
  If you are a current Creative Cloud member who has been using Lightroom and you want to stick with what you’re used to, simply use Lightroom Classic CC. Be sure to update to the most recent version to enjoy the significant performance improvements.

- **I’d like to check out the new Lightroom CC. How do I do that?**
  
  Simply install it using the Creative Cloud desktop app. You can enjoy it using the 20GB of cloud storage in your plan. Lightroom CC is also available on mobile devices and on the web. Download Lightroom CC on mobile in the Apple app store or Google Play app store. Or access Lightroom CC on the web at [lightroom.adobe.com](http://lightroom.adobe.com).

- **Does the new Lightroom CC have all the features in the Lightroom Classic CC?**
  
  If you’ve used Lightroom in the past, you may notice that the new Lightroom CC does not yet include all of the features that have existed in Lightroom in the past. This is a version 1.0 of the new Lightroom CC; it meets the needs of many users today. If there are key features or capabilities that you’d like to see added, please give us feedback [here](#).
  
  We’re actively developing Lightroom CC on the desktop and will inform you of the new features added in each update.

- **How does Lightroom Classic CC work with Lightroom CC on mobile and web?**
  
  Creative Cloud Photography plan has always offered the ability to edit photos from Lightroom on mobile and web. But, there are two areas of key differences in how the all-new Lightroom CC service interacts with the cloud and how Lightroom Classic CC does so.
As a Creative Cloud Photography member, I see that the current storage is limited to 20 GB. Is that a change? What was this limit earlier?

Creative Cloud Photography plan has never included storage per se. With Lightroom Classic CC, your edits sync back to the originals on your desktop via SmartPreviews (lower resolution proxies). Only photos taken on your mobile device are at full resolution. 20 GB is more than enough to handle this syncing, and should not be looked at as storage or backup.

If you choose to use Lightroom CC as a Creative Cloud Photography member, 20 GB is enough to give you a taste of the full-cloud photo service. If you would like the full 1TB of cloud storage or more, you can upgrade to the Creative Cloud Photography plan with 1TB. Here's how to change your Creative Cloud plan.

What if I need more than the 20 GB of storage?

Creative Cloud Photography plan provides 20 GB of storage by default. If you need more storage, you can purchase a 1 TB storage plan through Adobe.com for $9.99/month. You can also purchase 2 TB, 5 TB, and 10 TB plans through your Adobe ID account (Plans & Products > Manage Plans > Switch Plan). For detailed instructions, see Change your Creative Cloud plan.

How long will Lightroom Classic CC be available, improved, and supported with customer support?

We are committed to meeting the needs of professional photographers and photography enthusiasts of all levels. Some will choose to use Lightroom CC, while others will continue to use Lightroom Classic CC. Both will be supported and updated with new features and improvements for the foreseeable future.

As a Creative Cloud All Apps member, how much cloud storage do I receive?

Creative Cloud All Apps members get access to the Lightroom CC app and can use it with the 100 GB of cloud storage included in their plan. An All Apps member can move up to the Lightroom CC service with the full 1 TB for an additional $9.99 per month.

What happens when I’m nearing or have hit my storage limit?

Lightroom CC prompts you that you’ll soon fill up all of your cloud storage. To continue enjoying the benefits of backup, and the ability to view all of your photos on a mobile device, you can upgrade to a full 1 TB of cloud storage.

Once you hit your cloud storage limit, you can still import photos into Lightroom CC on the desktop, but those photos will be stored only on your local drive. They are not backed up to the cloud. They’re also not available via Lightroom CC on mobile or the web. Also note that the ability to search on whatever objects are present in your photo requires that your photos are in the cloud. Look for the icon to check which photos are backed up to the cloud. The icon indicates that the original of the photo is not backed up to the cloud.

When you’ve reached 100% of your cloud storage...
Lightroom CC prompts you that you’ve filled up all of your cloud storage. To continue enjoying the benefits of backup, and the ability to view all of your photos on a mobile device, you can upgrade to a full 1 TB of cloud storage.

After you’ve hit your cloud storage limit, you can still import photos into Lightroom CC on the desktop, but those photos are stored on your local drive only. They are not backed up to the cloud, nor do they become available via Lightroom CC on mobile or the web. Also note that searching based on whatever objects are present in your photo requires that your photos are in the cloud. Look for the icon to check which photos are backed up to the cloud. The icon indicates that the original of the photo is not backed up to the cloud.

Should I use Lightroom Classic and Lightroom CC together?

We encourage anyone who currently uses Lightroom Classic to download and try Lightroom CC in order to decide if you’d like to switch to Lightroom CC. Our recommendation is that you pick one and use it on an ongoing basis. We don’t recommend using both together in the long term.

Add photos

Adding photos to Lightroom CC involves a few simple steps.

Lightroom CC makes a copy of the photos imported and uploads your full resolution original photos to the cloud. So, once you’ve imported the photos, you can consider deleting or moving the originals from their source, such as the memory card.

1 Launch Lightroom CC.

2 Add photos from a camera device

Connect the camera or card reader to your computer. If necessary, see your camera manufacturer’s documentation for instructions on how to connect it to the computer.

Click icon at the upper-left corner of the window. Alternatively, choose File > Add Photos... from the menu bar. From the context-menu that appears, choose the camera.

Your images will be available to review before adding to Lightroom CC. This is described in Step 3 below.
Add photos from a camera

Add photos from a hard drive folder

Click icon at the upper-left corner of the window. Alternatively, choose File > Add Photos... from the menu bar. A dialog to select files from a local folder on your hard drive appears.

Note:

If a camera device or card reader is connected to your computer, clicking icon brings up a context menu. In this case, choose Browse from the context menu. Choosing this option brings up a dialog to select files or folders on your hard drive.

In the dialog that appears, do any of the following:

- Navigate and choose a folder containing the image files that you want to add. Then, click Review For Import (Mac)/Choose Folder (Win).
- Navigate and choose one or more image files that you want to add. Then, click Review For Import.

Your images will be available to review before adding to Lightroom CC. This is described in Step 3 below.
You’re looking at previews of your images. In this screen, you can select the images you’d like to add to Lightroom CC.

To select a photo for import, move the pointer over that photo and click the gray circular overlay that appears at the upper-left corner of the thumbnail. A blue check mark in the upper-left corner of the thumbnail indicates that the photo is selected for import.
Introduction

- To select all the thumbnails appearing in the import screen, check the Select All option at the upper-right corner.

- To deselect any photo, click the blue check mark in the upper-left corner of the thumbnail.

Note:

**Duplicate photos**

While adding photos, Lightroom CC automatically detects 'duplicate' photos. In the import screen, a Previously Added text overlay on a thumbnail indicates that you've already added that photo in Lightroom CC. You can't add photos that are identified as duplicate.

*If you think that a photo has been incorrectly identified as duplicate, you can work around this issue by renaming the photo in Explorer (Win)/Finder (Mac) and then adding it in Lightroom CC.*

**Add photos to an Album**

Click the Add To Album drop-down list and choose any of the following:

- To add the selected photos but not as part of any Album, choose None.
- To create an Album and add the selected photos into the new Album, choose New.
- To add the selected photos into an existing Album, choose any of Album names displayed in the drop-down list.

4 Click Add Photos.

Note:

When you add photos, Lightroom CC saves them to the local storage location specified in the preferences. Therefore, the used disk space displayed in the Local Storage preferences may temporarily indicate a higher value. Once these photos are fully synced to the cloud, Lightroom CC manages the used space so that your photos don't fill up your hard drive space.

Your recently added photos are displayed in **Photo Grid**.

---

**Edit photos**

You can access the Edit controls in Detail view. In the Edit panel, the edit controls are organized under various panels that you can expand/collapse to access those controls?Profile, Light, Color, Effects, Detail, Optics, and Geometry. To help you visually understand the effect that each of these edit controls produce in your photo, this article provides accompanying animations and visuals to illustrate the concepts.

To begin editing a photo using any of the Edit controls, do the following:

1 Click ( ) icon on the left to bring up My Photos panel.

   In My Photos panel, choose the album that contains the photo that you want to edit.
2 If you’re in Photo Grid (** ) view or Square Grid (** ) view, select the photo that you want to edit. Now, click (** ) icon in the toolbar at the bottom to switch to Detail view.

   If you’re already in Detail (** ) view, select the photo that you want to edit from the filmstrip appearing at the bottom of your current selection.

   Note:

   The Edit controls are only available in Detail view.

3 To bring up the Edit panel in Detail view, click (** ) icon at the upper-right corner.

   You can now expand/collapse the panels to access edit controls organized under?Profile, Light, Color, Effects, Detail, Optics, and Geometry. These edit controls are explained in detail below.

Profile

Note:

Beginning with Lightroom CC 1.4 June 2018 release, Presets and Profiles (including third-party, custom user presets and profiles) sync automatically across Lightroom CC desktop and mobile.

However, the custom user presets and profiles do not sync with Lightroom Classic CC desktop.

Profiles allow you to control how colors and tonality are rendered in your photos. The profiles provided in the Profile panel are intended to serve as a starting point or foundation for making image edits.

Applying a profile on your photo doesn’t change or overwrite the value of other edit control sliders. Therefore, you can make edits to your photos as you like and then choose to apply a profile on top of your edited image.

Browse and apply profiles

To browse and apply profiles, do the following:

1 If you’re in Photo Grid (** ) view or Square Grid (** ) view, select a photo that you want to edit. Now, click (** ) icon in the toolbar at the bottom to switch to Detail view.

   If you’re already in Detail (** ) view, select a photo that you want to edit from the filmstrip appearing at the bottom of your current selection.

   Click (** ) icon at the upper-right corner to bring up the Edit panel.

   In the Profile panel at the top, use the Profile pop-up menu to quickly access Adobe Raw profiles. To view other available profiles, click Browse.
Introduction

Browse profiles in the Profile panel.

Profile groups for a raw photo.

Note:
When you import photos, Adobe Color and Adobe Monochrome profiles are applied by default to color and black-and-white photos respectively.

2 Expand any of the profile groups (explained below) to view the profiles available in that group.

Note:
While browsing the profiles in the Profile panel, click the three-dot menu to access the viewing and filtering options. You can choose to view the profiles as a List, as Grid thumbnails, or Large thumbnails. You can also filter the profiles to be displayed by ‘type’ - Color or B&W.

Favorites: Displays profiles that you’ve marked as favorite. See Add a profile to Favorites.
Creative profiles for raw and non-raw photos

Creative profiles work on any file type including raw photos, JPEGs, and TIFFs. These profiles are designed to create a certain style or effect in your photo.

Artistic: Use these profiles if you want the color rendering in your photo to be more edgy, with stronger color shifts.

B&W: Use these profiles to get optimal tone shifts required for black and white work.

Modern: Use these profiles to create unique effects that fit in with the modern photography styles.

Vintage: Use these profiles to replicate the effects of vintage photos.

Profiles for raw photos

The following profile groups appear when you are editing a raw photo.

Adobe Raw: Adobe Raw profiles significantly improve color rendering and provide a good starting point for editing your raw images. Adobe Color profile?which is designed to provide a good color/tone balance for any image?is applied by default to the raw photos that you import in Lightroom CC.

Camera Matching: Displays profiles based on the camera make/model of your raw photo. Use Camera Matching profiles if you prefer the color rendering in your raw files to match what you see on your camera's display screen.

Legacy: Displays legacy profiles that were also provided in the earlier versions of the Lightroom app.
Note:

When you apply any of the Artistic, B&W, Modern, and Vintage profiles, Lightroom CC provides an additional Amount slider that allows to control profile intensity.

3 Move the pointer over any profile to preview its effect in your photo. Click the profile to apply it to your photo.

Add a profile to Favorites

To add a profile to the Favorites profile group:

- When browsing the profiles in the Grid or Large view, hover on the profile thumbnail and click the star icon that appears at the upper-right corner of the thumbnail.
- When browsing the profiles in the list view, hover on the profile and click the star icon that appears next to the profile’s name.

Import profiles

Note:

When you launch Lightroom CC for the first time after updating to the latest version, the existing DCP profiles on your computer are automatically converted to XMP format. If you want to add a DCP profile after that first launch, copy them manually to the following locations:

Win: C:\ProgramData\Adobe\CameraRaw\CameraProfiles
Mac: ~/Library/Application Support/Adobe/CameraRaw/CameraProfiles (This is the user path)

You can import third-party camera profiles in XMP format. Do the following:

1 In the Profile panel, click Browse.
2 Click the three-dot icon at the upper-right corner of the Profile panel. Then, select **Import Profiles** option from the pop-up menu.

3 In the **Import Profiles** dialog that appears, browse to the required path and select one or more XMP profiles.

4 Click **Import**.

**Manage profiles**

Lightroom CC allows you to show or hide various profile groups that are displayed in the **Profile** browser - **Adobe Raw**, **Camera Matching**, **Legacy**, **Artistic**, **B&W**, **Modern**, **Vintage**, or any other profiles that you've imported.

To show/hide profile groups in Lightroom CC, follow the steps below:

*Note:*

Your settings to show/hide profile groups is specific to each computer or device. For example, you can hide some profile groups in Lightroom CC desktop but they will still be visible in Lightroom CC on your mobile device and vice versa.

1 Click () icon at the upper-right corner to bring up the **Edit** panel.

   In the **Profile** panel at the top, click **Browse**.

2 Click the three-dot icon at the upper-right corner of the **Profile** panel. Then, select **Manage Profiles** option from the pop-up menu.

3 Under **Manage**, select the profile groups that you want to show in the Profile browser. Deselect the profile groups that you want to hide from the Profile browser.

4 Click **Back** to navigate back to the **Profile** browser.

**Profile** browser now displays only those profile groups which you've selected using the **Manage Profiles** option.

**Light**

Using the slider controls provided in the **Light** panel, you can adjust the overall tonal range of your image.

<table>
<thead>
<tr>
<th>Exposure</th>
<th>Contrast</th>
<th>Highlights</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Exposure" /></td>
<td><img src="image2.png" alt="Contrast" /></td>
<td><img src="image3.png" alt="Highlights" /></td>
</tr>
</tbody>
</table>

*Note:*

In the **Light** panel, click the **AUTO** button to have Lightroom CC automatically apply the best edits for these slider controls in your photos: **Exposure**, **Contrast**, **Highlights**, **Shadows**, **Whites**, **Blacks**, **Saturation**, and **Vibrance**.

**Exposure:** Controls the brightness of your photo. Move the slider to the left to make the image darker; move it to the right to make the image brighter.

**Contrast:** Determines the contrast between light and dark colors. Move the slider to the left to flatten the contrast; move it to the right to make the contrast more dramatic.

**Highlights:** Controls the brightness of the lighter parts of your photo. Move the slider to the left to darken highlights to recover details; move it to the right to brighten them and reduce details.
**Shadows**: Controls the brightness of the lighter parts of your photo. Move the slider to the left to deepen shadows; move it to the right to brighten them and recover details.

**Whites**: Sets the white point of the image. Move the slider to the right to make more colors appear completely white.

**Blacks**: Sets the black point of the image. Move the slider to the left to make more colors appear completely black.

**Fine-tune the tonal scale using the Tone Curve**

Note:

*In Lightroom CC 1.4 (June 2018 release), the following changes have been introduced:*

- The **Medium Contrast** and **Strong Contrast** tone curve options have been removed.
- The ability to save tone curves and apply saved curves within the **Tone Curve** panel has been removed.

*Going forward, the tone curves should be saved as a preset so that they can sync across the Lightroom CC ecosystem of apps. See this TechNote for detailed information.*

The **Tone Curve** in the **Light** panel gives you greater control over the tonal range and contrast in your photo. Click the icon to expand the Tone Curve subpanel.

The horizontal axis represents the original tonal values (input values), with black on the left and progressively lighter values toward the right. The vertical axis represents the changed tone values (output values), with black on the bottom and lighter values progressing to white at the top.
If a point on the curve moves up, it becomes a lighter tone; if it moves down, it becomes darker. A straight, 45-degree line indicates no changes to the tonal scale; the original input values exactly match the output values.

To make adjustments to the Tone Curve, click on the curve and drag up or down. As you drag, the affected region and the new tonal value is displayed in the lower-right corner of the tone curve.

You can also choose to make adjustments to the Point Curve in the Red, Green, or Blue Channels individually or all three channels at once. Do the following to select a Channel and adjust its Point Curve:

![Representative Point Curve screenshot showing Control Points on the Red Channel.](image)

1. Choose a Point Curve option provided above the curve: RGB Channels, Red Channel, Green Channel, or Blue Channel.
2. Click on the curve to add a Control Point. To remove a Control Point on the curve, right-click (Windows) or Control-click (Mac OS) and choose Delete Control Point from the menu.
3. Drag a point to edit it.
4. (Optional) Choose an option from the Curve dropdown (at the lower-right corner): Linear, Medium Contrast, or Strong Contrast.
5. To return to a linear curve at any time, right-click (Windows) or Control-click (macOS) anywhere in the graph and choose Reset Channel.

**Color**

Using the slider controls in the Color panel, you can adjust colors in your image.

- Set White Balance by choosing a preset option or specifying a neutral area in the photo with the White Balance Selector.
- Fine-tune the white balance using the Temp and Tint controls.
- Adjust the color saturation (vividness) using the Vibrance and Saturation controls.
- Convert the photo to Black & White using the B&W button.
- Fine-tune individual colors using the Hue, Saturation, and Luminance (HSL) sliders.
### Temp
![Temp: Determines how cool or warm the colors appear in your photo. Move the slider to the left if colors are too yellow; move it to the right if colors are too blue.](image)

### Tint
![Tint: Determines how green or purple the colors appear in your photo. Move the slider to the left if colors are too purple; move it to the right if colors are too green.](image)

### Vibrance
![Vibrance: Increases the saturation of lower-saturated colors more than higher-saturated colors, which can help prevent skin-tones from looking unnatural.](image)

### Saturation
![Saturation: Boosts the saturation of all colors equally. Move the slider to the left to de-saturate colors, move it to the right to boost saturation.](image)
Effects

<table>
<thead>
<tr>
<th>Clarity</th>
<th>Dehaze</th>
<th>Vignette</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Clarity" /></td>
<td><img src="image2.png" alt="Dehaze" /></td>
<td><img src="image3.png" alt="Vignette" /></td>
</tr>
</tbody>
</table>

**Clarity**: Changes the contrast around the edges of objects in your photo. Move the slider to the left to soften portraits; move it to the right to make landscapes clearer.

**Dehaze**: Move the slider to the left to add simulated haze; move it to the right to remove haze.

**Vignette**: Makes the outer edges of the photo lighter or darker. Adjust the Vignette sliders:
- **Feather**: Lower values reduce softening between the vignette and the vignette's surrounding pixels. Higher values increase the softening.
- **Midpoint**: Lower values apply the Amount adjustment to a larger area away from the corners. Higher values restrict the adjustment to an area closer to the corners.
- **Roundness**: Lower values make the vignette effect more oval. Higher values make the vignette effect more circular.
- **Highlights**: Controls the degree of highlight contrast preserved when Amount is negative. Suitable for photos with small highlights, such as candles and lamps.

**Split Toning**

Using the Split Toning controls in the Effects panel, you can create a split tone effect in which a different color is applied to the Shadows and Highlights in your photo. For example, you can colorize a monochrome photo or apply special effects, such as the look of cross-processed film, to a color photo.

Split tone effect created on a monochrome image.

To create a split tone effect in your photo, do the following:

1. In the Effects panel, click the Split Toning icon to view the **Split Toning** controls.
2 Set the **Hue** and **Saturation** values by individually selecting the Shadows or Highlights swatches, then dragging the corresponding controls point to select a color in the color ramp. Note that **Hue** sets the color of the tone; while **Saturation** adjusts the intensity of the color.

3 Set the Balance slider (located between the Shadows and Highlights swatches) to balance the effect between the **Highlight** and **Shadow** sliders. Move the slider to the right to favor the selected **Highlights** color; move the slider to the left to favor the selected **Shadows** color.

**Detail**

Using the slider controls provided under the **Detail** panel, you can sharpen your photo to enhance edge definition and bring out detail, as well as remove image noise that can degrade image quality. Image noise includes luminance (grayscale) noise, which makes an image look grainy, and chroma (color) noise, which is usually visible as colored artifacts in the image. Photos taken with high ISO speeds can have noticeable noise.

<table>
<thead>
<tr>
<th>Sharpening</th>
<th>Noise Reduction</th>
<th>Color Noise Reduction</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Sharpening" /></td>
<td><img src="image2.png" alt="Noise Reduction" /></td>
<td><img src="image3.png" alt="Color Noise Reduction" /></td>
</tr>
</tbody>
</table>

**Grain**

![Grain](image4.png)

**Sharpening:** Move the slider to the right to sharpen details.

- **Radius:** Adjusts the size of the details that sharpening is applied to. Photos with fine details may need a lower radius setting. Photos with larger details may be able to use a larger radius. Using too large a radius generally results in unnatural-looking results.
• **Detail:** Adjusts how much high-frequency information is sharpened in the image and how much the sharpening process emphasizes edges. Lower settings primarily sharpen edges to remove blurring. Higher values are useful for making the textures in the image more pronounced.

• **Masking:** Controls an edge mask. With a setting of zero (0), everything in the image receives the same amount of sharpening. With a setting of 100, sharpening is mostly restricted to those areas near the strongest edges.

**Noise Reduction:** Move the slider to the right to reduce luminance noise.

• **Detail:** Controls the luminance noise threshold. Useful for noisy photos. Higher values preserve more detail but may produce noisier results. Lower values produce cleaner results but may also remove some detail.

• **Contrast:** Controls luminance contrast. Useful for noisy photos. Higher values preserve contrast but may produce noisy blotches or mottling. Lower values produce smoother results but may also have less contrast.

**Color Noise Reduction:** Move the slider to the right to reduce color noise.

• **Detail:** Controls the color noise threshold. Higher values protect thin, detailed color edges but may result in color speckling. Lower values remove color speckles but may result in color bleeding.

• **Smoothness:** Higher values apply a softened effect to the speckled color tones.

**Grain:** Move the slider to the right to add film grain.

• **Size:** Controls grain particle size. At sizes of 25 or greater, blue is added to make the effect look better with noise reduction.

• **Roughness:** Controls the regularity of the grain. Move left to make the grain more uniform; move to the right to make the grain more uneven.

**Optics**

Camera lenses can exhibit different types of defects at certain focal lengths, f-stops, and focus distances. You can correct and/or minimize these issues using the options provided in the **Optics** panel.

**Correct chromatic aberration**

Chromatic aberration appears as a color fringe along the edges of objects. It is caused by the failure of the lens to focus different colors to the same spot, aberrations in sensor microlenses, and by flare.

**Chromatic Aberration:** Select the check box to automatically correct blue-yellow and red-green fringes in your image.
Enable lens corrections

Lightroom CC includes numerous lens profiles, which can be used to correct common lens aberrations such as geometric distortion and vignetting. The profiles are based on metadata that identifies the camera and lens used to capture the photo, and then compensates accordingly.

1. In the Optics panel, select the Enable Lens Corrections check box.

Enable Lens Correction

Lightroom CC automatically selects a matching lens profile based on the camera model, focal length, f-stop and focus distance information in your photo’s metadata.

Cameras with built-in lens profile support

Lens correction for all Micro 4/3 (MFT) lenses and cameras, including Panasonic, Olympus, and other cameras (Fuji X, Leica Q, plus many point-and-shoot models from Canon) happens automatically without your interaction.

If your lens is supported automatically, Lightroom CC displays the message ‘Built-in Lens Profile Applied’ in the Optics panel (see the image below).

Built-in Lens Profile applied. Click the info icon to view Lens Profile information.
2 (Optional) If Lightroom CC is unable to find a matching lens profile automatically or if you want to change the automatic selection, do the following:

a Click the current lens profile to change the automatic selection or click Manually Select a Profile if Lightroom CC couldn’t find a lens profile automatically.

b In the Select a Lens Profile dialog box, select a Make, Model, and Profile.

The lens profiles that are available depend on whether you’re adjusting a raw or a non-raw file. For a list of supported lenses, see Supported lenses.

![Manually select a profile](image)

3 If desired, customize the correction applied by the profile by using the following sliders:

**Distortion Correction**: The default value 100 applies 100% of the distortion correction in the profile. Values over 100 apply greater correction to the distortion; values under 100 apply less correction to the distortion.

**Lens Vignetting**: The default value 100 applies 100% of the vignetting correction in the profile. Values over 100 apply greater correction to vignetting; values under 100 apply less correction to vignetting.

**Geometry**

A close distance to the subject, as well as certain types of lenses, can distort perspective and make straight lines appear bowed, tilted or skewed in your photos. You can correct for these issues using the controls in the Geometry panel.
The **Upright** control provides four automatic perspective correction options - **Auto**, **Level**, **Vertical**, and **Full**, as well as a manual **Guided** option. After applying Upright, you can refine the adjustment using the Manual Transform sliders.

### Choose an Upright mode to correct perspective

1. Choose a photo to correct.

2. (Recommended) In the **Detail** view, open the **Edit** control and navigate to the **Optics** panel. Select the **Enable lens corrections** check box.
Note:

*Enabling lens corrections is highly recommended, before processing the photo with the Upright modes.*

3 Navigate to the **Geometry** panel. From **Upright** menu, choose an option to apply the correction to the photo.

- **Guided:** Allows you to draw up to four guides on your photo to customize perspective correction.
- **Auto:** Corrects both vertical and horizontal perspective while balancing the overall image, preserving as much of the visible image area as possible.
- **Level:** Corrects horizontal perspective.
- **Vertical:** Corrects vertical perspective.
- **Full:** Combines all Upright correction types to automatically correct perspective.

**Using Guided Upright Tool**

If you chose the **Upright** mode as **Guided**, do the following:

1. Click the Guided Upright Tool icon and then draw the guides directly on your photo.

![Guided Upright Tool](image)

2. Once you have drawn at least two guides, the photo transforms interactively.

![Three guides drawn over the photo using Guided Upright Tool.](image)

4 Cycle through the **Upright** modes until you find the most preferable setting.
All the Upright modes correct and manage distortion and perspective errors. The best setting varies from one photo to another. Experiment with the modes before deciding on the best possible mode for your photo.

5 (Optional) When correcting the perspective of a photo, you may get white areas near the image boundaries. To prevent this, select the Constrain Crop option to automatically crop the photo according to the original dimension.

6 Use Manual Transforms to fine-tune the perspective corrections - Distortion, Vertical, Horizontal, Rotate, Aspect, Scale, X Offset, Y Offset.
Introduction

Image with corrected perspective.

Manual Transforms

Last updated 10/15/2018
Copy and paste edits
Lightroom CC allows you to copy the edits that you've applied on a photo and paste it across multiple photos. You can also choose which edit settings you want to copy from a photo.

1 Select a photo.
If you're in Photo Grid (grid icon) view or Square Grid (square icon) view, select a photo from which you want to copy the edit settings.
If you're in Detail (icon) view, you can copy the edit settings from your current photo or choose the required photo from the filmstrip appearing at the bottom of your current selection.

2 Copy all the edit settings from the selected photo.
To copy the current photo's edit settings, do one of the following:
• From the menu bar, choose Photo > Copy Edit Settings.
• Press Control + C (Win) or Command + C (Mac) keys.

Choose which edit settings to copy from the selected photo.
To choose edit settings to copy from the selected photo:
• From the menu bar, choose Photo > Choose Edit Settings To Copy. Alternatively, press Control + Shift + C (Win) or Shift + Command + C (Mac) keys.

a From the Copy Settings dialog that appears, click the Select pop-up menu at the top and choose any of the following:
  1 All: Selects all the edit settings groups.
  2 Modified: Selects only the edits settings that you've modified or applied on the selected photo.
  3 Default: Selects the default set of edit settings. Tools and Geometry settings are excluded by default.
  4 None: Deselects all the edit settings.

a You can also manually select or deselect specific settings by expanding the edit setting groups.

b After making the selection, choose Copy.
5 Select one or more photos to which you want to paste the copied edit settings.

If you’re in **Photo Grid** ( ) view or **Square Grid** ( ) view, select one or more photos to which you want to paste the edit settings.

If you’re in **Detail** ( ) view, select one or more photos from the filmstrip.

6 Paste the copied settings.

To paste the copied edit settings to the selected photos, do one of the following:

- From the menu bar, choose **Photo > Paste Edit Settings**.
- Press Control + V (Win) or Command + V (Mac) keys.

**Presets**

**Note:**

*Beginning with Lightroom CC 1.4 June 2018 release, Presets and Profiles (including third-party, custom user presets and profiles) sync automatically across Lightroom CC desktop and mobile.*

*However, the custom user presets and profiles do not sync with Lightroom Classic CC desktop.*

**Preview and apply develop presets**

1 If you’re in **Photo Grid** ( ) view or **Square Grid** ( ) view, select a photo that you want to edit. Now, click ( ) icon in the toolbar at the bottom to switch to **Detail** view.

If you’re already in **Detail** ( ) view, select a photo that you want to edit from the filmstrip appearing at the bottom of your current selection.
2 Click () icon at the upper-right corner to bring up the Edit panel.
   In the Edit panel, click Presets at the bottom.

3 In Presets panel, the default presets are grouped under Color, Creative, B&W, Details, and Components. The user-created presets are available under User Presets. Expand any group to reveal its presets.
   • To preview the effect of a preset on your photo, move the pointer over it in the Presets panel.
   • To apply a preset to the photo, click it in the Presets panel.

Create a user preset
You can create and save custom develop presets based on the current edit control settings (in the Edit panel) of the selected photo.

1 In Detail view, choose a photo based on which you want to create a user preset.
2 Click () icon at the upper-right corner to bring up the Edit panel.
   In the Edit panel, click Presets at the bottom.
3 In the Presets panel, click the three-dots () icon and choose Create Preset from the pop-up menu.
4 In the New Preset dialog that appears, specify a name for your preset. Click Save.
   The saved preset is added in the list of User Presets in the Presets panel.

Note:
If you’re looking to migrate your Lightroom Classic CC develop presets into Lightroom CC, see Migrate Presets.

Update a user preset
To update a saved user preset, do the following:

1 In Detail view, click () icon at the upper-right corner to bring up the Edit panel.
   In the Edit panel, click Presets at the bottom.
2 In the Presets panel, expand the User Presets group.
3 Select a user preset to apply it on the photo and then modify the edit settings (in the Edit panel) as required.
4 Now, right-click the user preset and select Update With Current Settings option in the pop-up menu.

Delete a user preset
You cannot delete built-in Lightroom CC presets. You can only delete the user presets.

1 In the Detail view, click () icon at the upper-right corner to bring up the Edit panel.
   In the Edit panel, click Presets at the bottom.
2 In the Presets panel, right-click a user preset and choose Delete from the pop-up menu.
3 In the Delete Preset dialog, click Delete to confirm the action. Otherwise, click Cancel.

Manage presets
Lightroom CC allows you to show or hide various preset groups that are displayed in the Presets panel - Color, Creative, B&W, Curve, Grain, Sharpening, Vignetting, and User Presets.

To show/hide preset groups in Lightroom CC, follow the steps below:

Note:
Introduction

Your settings to show/hide preset groups is specific to each computer or device. For example, you can hide some preset groups in Lightroom CC desktop but they will still be visible in Lightroom CC on your mobile device and vice versa.

1 Click (획) icon at the upper-right corner to bring up the Edit panel.
   In the Edit panel, click Presets at the bottom.

2 In the Presets panel, click the three-dots (획) icon and choose Manage Presets from the pop-up menu.

3 Under Manage, select the preset groups that you want to show in the Presets panel. Deselect the preset groups that you want to hide from the Presets panel.

4 Click Back to navigate back to the Presets panel.

Presets panel now displays only those preset groups which you’ve selected using the Manage Presets option.

Reset photo edits

Lightroom CC allows you to restore your edited photo to its original state (when you first imported it). You can also restore your photo edits to the state when last opened it Lightroom CC. To reset your photo edits, you must be in Detail view.

1 Open the photo in Detail view
   If you’re in Photo Grid (㎡) view or Square Grid (㎡) view, select an edited photo that you want to reset. Now, click (획) icon in the toolbar at the bottom to switch to Detail view.
   If you’re already in Detail (㎡) view, select the photo that you want to reset from the filmstrip appearing at the bottom of your current selection.

2 Restore the photo to its original state
   Do one of the following:
   • From the menu bar, choose Photo > Reset To Original.
   • Press Shift + R keys.

Restore the photo to its last opened state
   Do one of the following:
   • From the menu bar, choose Photo > Reset To Open.
   • Press Shift + Command + R keys.

Common questions

• How do I migrate profiles from Lightroom Classic CC to Lightroom CC?
   For help instructions, see Import profiles.

   Note:
   If you’re looking to migrate your Lightroom Classic CC develop presets into Lightroom CC, see Migrate Presets.

• How do I use my Lightroom Classic CC profiles and presets in Lightroom CC for mobile?
   1 Install Lightroom CC on your desktop.
   2 Launch Lightroom CC desktop.
When you launch Lightroom CC desktop (v1.4 June 2018 release or later) for the first time after installing or updating, the existing Lightroom Classic profiles and presets on your computer are automatically migrated to Lightroom CC.

3 (Optional) If you make any changes or add new presets to Lightroom Classic (after auto-migration to Lightroom CC desktop), do one of the following:

a. Migrate the new/updated presets to Lightroom CC manually
For Help instructions, see Migrate Presets.

b. Use the import dialog in Lightroom CC desktop
   a. From the menu bar, choose File > Import Profiles & Presets.
   b. In the Import dialog that appears, browse to the required path and select the presets that you want to import.
      Check the file location for Lightroom Classic CC presets on Win and macOS.
   c. Click Import.

4 Make sure that the Lightroom CC app on your mobile device is updated to the latest version.
The presets and profiles that you’ve installed in Lightroom CC desktop will automatically sync with Lightroom CC on mobile.

• How do I install new presets and profiles into Lightroom CC?
   1. From the menu bar, choose File > Import Profiles & Presets.
   2. In the Import dialog that appears, browse to the required path and select profiles or presets that you want to import.
   3. Click Import.

• How do I install VSCO presets and profiles into Lightroom CC?
   1. First, install the VSCO presets and profiles into Lightroom Classic CC.
      VSCO preset packs include an installer.
   2. Open Lightroom CC.

3 Import all the VSCO presets.
   From the menu bar, choose File > Import Profiles & Presets.
   In the Import dialog that appears, navigate to the path below and select the VSCO presets that you installed in Step 1.
   Win: C:\ProgramData\Adobe\CameraRaw\Settings
   Mac: ~/Library/Application Support/Adobe/CameraRaw/Settings
   Click Import.

4 Import all the VSCO profiles.
   From the menu bar, choose File > Import Profiles & Presets.
   In the Import dialog that appears, navigate to the path below and select the VSCO profiles that you installed in Step 1.
   Win: C:\ProgramData\Adobe\CameraRaw\CameraProfiles
   Mac: ~/Library/Application Support/Adobe/CameraRaw/CameraProfiles
   Click Import.
• How do I install new XRite Passport profiles and DNG Profile Creator profiles into Lightroom CC?

When you launch Lightroom CC for the first time after updating to the latest version, the existing profiles on your computer are automatically added. If you want to install new XRite or DNG Profile Creator profiles after the first launch, do the following:

1. Save the profiles from XRite or DNG Profile Creator to your desktop.
2. Open Lightroom CC.
   From the menu bar, choose File > Import Profiles & Presets.
3. In the Import dialog that appears, browse and select the profiles that you saved in Step 1.
4. Click Import.

• How do I install Camera Raw created V2 profiles into Lightroom CC?

1. In Lightroom CC, choose File > Import Profiles & Presets from the menu bar.
2. In the Import dialog that appears, navigate to the path below and select the profiles that you want to import.
   Win: C:\ProgramData\Adobe\CameraRaw\CameraProfiles
   Mac: ~/Library/Application Support/Adobe/CameraRaw/CameraProfiles
3. Click Import.

Organize photos

Lightroom CC offers many ways to organize your photos. You can manage your photos as albums or stacks; or organize them using keywords, metadata, flags, and ratings. Finding and filtering photos in Lightroom CC is also easy.
Organize your photos in Lightroom CC.

A Add Photos B My Photos panel C Sharing panel D Views (Photo Grid, Square Grid, and Detail) E Sort options F Flags, Ratings G Grid Size H Info panel I Keywords panel J Editing tools K Sync activity and status L Help M Share N Filter O Search

**View photos**

In the My Photos panel in the left pane, you can quickly select what photos you want to view in the grid to the right:

- All Photos
- Recently Added
- By Date (arranged chronologically)
- People
- Albums

In the Sharing panel in the left pane, you can view the photos and albums you've published on Adobe Portfolio website or shared as a web gallery:

- Connections
- Shared To Web

To specify how you want to display photos in the grid, choose one of the views from the bottom of the photo grid:

- **Photo Grid**: Displays photos as thumbnails with no borders or badges
- **Square Grid**: Displays photos as equal-sized thumbnails along with their flag status, sync status, and rating
- **Detail**: Lets you work with and edit individual photos. Edit controls are active only in this view.
**View photos on full screen**

To view your album photos on full-screen, do the following:

1. Switch to **Detail** view. You can enter the full-screen mode only from this view.
2. Press F key to enter the full-screen mode. Alternatively, choose **View > Detail - Full Screen** from the menu bar.
3. Lightroom CC hides all the panels and maximizes your photo to display on the full screen. While in this full-screen view, you can perform any of the following actions:
   1. Cycle through your album photos by pressing Left or Right arrow keys.
   2. Flag a photo as **Pick** or **Rejected** by pressing the Z or X keys, respectively.
   3. Rate a photo by pressing the 0-5 number keys.
4. To leave the full-screen mode, press F or the Esc key.

**Add your photos to an album**

1. In the left pane, in the Albums area, click **Add An Album**. Alternatively, click the + icon and then click **Create Album**.
2. Enter a name for the new album. Click **Create**.
3. Select some photos from the grid and drag them to the album in the left pane.
4. Add more photos to the album if necessary.

*Note:*

To rename or delete an album, right-click its name in the left pane and then click the appropriate option.

**Organize albums into folders**

Folders can contain albums or other folders.

1. In the Albums area in the left pane, click the + icon. Click **Create Folder**. Lightroom CC lists the folder in the Albums area.
2. Drag one or more albums under the folder.
3. If necessary, create subfolders and add albums to them.

**Show which albums a photo belongs to**

In the **Albums** section at the bottom of the **Info** panel, you can check all the albums that your currently selected photo belongs to.

1. Select a photo in the grid.
2. Bring up the **Info** panel by clicking ( ) from the lower-right corner of the window.
Find the albums your selected photo belongs to.

3 In the Info panel, scroll to the **Albums** section at the bottom to find a list of albums the selected photo is a part of.
   • Click the album name to view all photos from that album.
   • The **Albums** section will display **None** if the selected photo is not a member of any album.
   • If you’ve **Store an album locally**, this badge 📦 appears beside that album’s name.

**Stack photos**

1 In the **Photo Grid** (📸) or **Square Grid** (📸) view, or in the **Detail** (👣) view filmstrip, select multiple photos.
2 Right-click the selection and choose **Group Into Stack**. Alternatively, select **Stacks > Group Into Stacks** from the **Edit** menu.

*Note:*

To dissolve a photo stack, right-click the stack and then select **Ungroup Stack**.

**Assign keywords to photos**

1 In the **Photo Grid** (📸) or **Square Grid** (📸) view, or in the **Detail** (👣) view filmstrip, select one or more photos.
2 Select **View > Keywords**. Alternatively, click the 📃 icon in the lower-left corner of the screen.
3 In the Keywords pane, assign one or more keywords to the photos.

**Rate and flag photos**

1 In the **Photo Grid** (📸) or **Square Grid** (📸) view, or in the **Detail** (👣) view filmstrip, select one or more photos.
2 Right-click the selection and assign a rating/flag to the photo using the **Set Rating** or **Set Flag** options.

*Note:*
In the Square Grid and Detail views, you can also rate and flag photos directly in the grid area. In the Square Grid, mouse-over the photo to view the rating and flag options.

Rate and flag photos in the grid area

Search, filter, and sort photos

Search photos
Find photos using the Search bar. Aside from searching photos by metadata and keywords, Lightroom CC can also find and display photos based on the objects in them, or facets associated with the photo.

Type any of the object name, or a facet name followed by a colon ':' in the Search bar. For example, you can type mountains in the Search bar to quickly search for all photos that have mountains in them, or you can type camera: to display a list of camera models used. The terms used in Search bar are not case-sensitive.

Search photos using Search bar in Lightroom CC

To search your photos, you can use any of the facets listed below. In the Search bar, type a facet name followed by a colon ':'.

- keyword:
**Introduction**

- camera:
- lens:
- location:
- rating:
- flag:
- flash:
- orientation:
- iso:
- type:
- f-stop:
- ss:
- edited:
- media:

**Filter photos**
Click the filter icon next to the Search bar to bring up the filter options:

- **Ratings**: Choose a star rating to view photos rated higher than or equal to the specified star rating. For example, you can select three stars to view photos rated three stars or higher.
- **Flags**: Choose flagged, rejected, or unflagged option to filter photos based on their flag status.
- **Show Photos Only**: Click to show photos only and exclude videos.
- **Show Videos Only**: Click to show videos only and exclude photos.
- **Keywords**: Choose a keyword from the drop-down list to show photos that are tagged with that keyword.
- **Cameras**: Choose a camera model from the drop-down list to filter photos based on the camera that was used to shoot them.
- **Locations**: Choose a location from the drop-down list to filter photos based on their location tag.
- **Sync Status**: Choose an option from the drop-down list to filter photos based on their sync status - Syncing, Synced and Backed Up, Original Stored Locally, or Synced From Lightroom Classic. To know more about the meaning of these Sync Status, see View photo metadata below.

**Sort photos**
In any view, click the sort icon at the lower-left corner of the Lightroom CC window to bring up the sorting options.

Choose one of the sorting option from the pop-up menu - **Capture Date, Import Date, Modified Date, File Name, or Star Rating**.

Clicking **Reverse Order** switches between ascending and descending order of the selected sorting option.
Change photo capture time

Lightroom CC allows you to adjust the date and time of an individual photo or a group of photos. Sometimes you need to change the capture time for your photos after clicking them. For example, you might need to change the capture times if you traveled to a different time zone and didn't change your camera’s date/time setting before you started photographing. Another scenario could be that you added a scanned photo to Lightroom CC and want the capture time to show the date on which the image was photographed rather than the date on which it was scanned.

1. Select one or more photos in the Photo Grid, Square Grid, or Filmstrip in the Detail view.
2. Bring up the Info panel by clicking the ( ) icon at the lower-right corner of the screen. In the Info panel, click the ( ) icon next to the Captured field displaying the capture date and time.
3. If you’ve selected a single photo, the Edit Date & Time dialog that appears displays the current date and time of your photo. Change the date and time to a desired value.

If you’ve selected a group of photos, the Shift Date Range dialog displays the current date range of your selection. The new date and time that you specify is applied to the photo with the most recent capture date in the group. Other selected photos automatically shift based on this new date.

Note:

See known issue: Edit Date & Time dialog does not load

4. Click the Change button.
View photo metadata

- Select a photo in the grid and then click the icon. Lightroom CC displays the Info panel that lists the metadata for the photo and its Sync Status.

- Here are the possible Sync Status badges that you may see:
  - **Synced and Backed Up** Lightroom CC may purge original files that haven't been accessed in a while, leaving a smaller smart preview that you can edit.
  - **Synced and Stored Locally** The original file is backed up to the cloud and also saved on your computer as part of the Store an album locally.
  - **Syncing changes up to the cloud** Lightroom CC is currently syncing your changes to the cloud.
  - **Synced from Lightroom Classic** There is no original backed up to the cloud, but a smart preview is available.
  - **Asset has error** For further information, view the Sync Status area in the Info panel or click this badge icon in the Square Grid view.

Save or share your photos

Share photos as a web gallery

Lightroom CC gives you the ability to make a selection of photos public so that others can see your photos on the web. If you want to create exclusive albums for your photos and share them to web, see Share an album as a web gallery.

To share a selection of photos, do the following: Share an album as a web gallery

1. Select photos that you want to share from the grid view or the filmstrip.
2. Right-click (Win) / Control+click (Mac) over your selection and select Share to Web from the context menu.
3. In the Share Settings dialog box that appears, a unique link is generated which you can use to share your selected photos. Edit the name of the set of photos being shared under the Title option. Also, you can specify the sharing Preferences:

   ![Share Settings dialog box](https://example.com/share-dialog-box.png)

   *Share an arbitrary selection of photos*
Preferences

Allow downloads: Select this preference to allow others to download the shared set of photos.

Show metadata: Select this preference to allow others to view metadata of the shared set of photos.

Show location data: Select this preference to allow others to view location info of the shared set of photos. Deselect it to hide location info.

Note:

To modify the sharing preferences of selected photos that are already public, do any of the following:

- Click the Sharing icon. In the Sharing panel under Shared to web, expand the Photos folder. Right-click (Win) / Control-click (Mac) the public photo and choose Share Settings from the context menu.
- Click the three-dots menu from the upper-right corner of the grid header and choose Share Settings.

4 Click Continue. Your set of selected photos is now public.

Add photos to a public photo gallery

To add photos to a public photo gallery, make a selection of photos from the grid view or the filmstrip. Click the Sharing icon to bring up the Sharing panel. Under Shared to Web, select Photos. Then, do any of the following:

- Right-click (Win) / Control-click (Mac) the public photo gallery name under Photos to which you want to add the new selection of photos. Select Add Selected Photos from the context menu.
- Drag the selection of photos over the name of a public photo gallery under Photos.

Your selected photos are now added to the desired public photo gallery.

Share to Adobe Portfolio

- Add a connection
- Share photos or albums to Adobe Portfolio
- Add photos to a public photo gallery or album

Lightroom CC allows you to share selected photos or albums and publish your creative work as an online project or a personalized website with Adobe Portfolio. To publish to Adobe Portfolio, you begin with adding a connection.

Add a connection

To add a connection, do the following:

1 Click the Sharing icon from the left pane.

2 In the Sharing panel, select the Add Connection option under Connections. Follow the instructions on the Add a Connection dialog box that opens to establish a connection to Adobe Portfolio.
Adobe Portfolio is visible in the Sharing panel as a connection

Note:

To remove Adobe Portfolio as a connection, right-click (Win) / Control+click (Mac) Adobe Portfolio in the Sharing panel and select Remove Connection. The connection to Adobe Portfolio is removed but all published content remains in your online portfolio until removed manually.

Share photos or albums to Adobe Portfolio

After you have added Adobe Portfolio as a Connection in Lightroom CC, you can share and publish photos or albums.

1 Do any one of the following:
   • To share a selection of photos, select one or more photos from the grid view or the filmstrip.
   • To share an album, click My Photos from the left pane and select an album under Albums.

2 Right-click (Win) / Control+click (Mac) over your selection of photos or the album name. Select Share To > Adobe Portfolio from the context menu.

3 In the Add a Title dialog box, type a name for the shared photos and click Continue.
   Your selection of photos or album is now shared with Adobe Portfolio.
   This step is not applicable if you are sharing an album to Adobe Portfolio.

4 You can also publish your shared photos and albums to Adobe Portfolio where you can edit the layout of your project and publish your site.

Click Go to My Portfolio from the blue grid header in the grid view to which you are directed immediately after sharing your photos or album. You can also click the portfolio link from the top of the grid header that is displayed after you close the blue grid header. Adobe Portfolio opens in your default web browser.

For Adobe Portfolio related Help resources, see Adobe Portfolio Help documentation.
Add photos to a public photo gallery or album
To add photos to a public photo gallery or album, make a selection of photos from the grid view or the filmstrip. Click the Sharing icon to display the Sharing panel. Under Connections, select Adobe Portfolio. Then, do any of the following:

- Right-click (Win) / Control-click (Mac) the public photo gallery or album name under Adobe Portfolio to which you want to add the new selection of photos. Select Add Selected Photos from the context menu.
- Drag the selection of photos over the name of a public photo gallery or album under Adobe Portfolio.

Your selected photos are now added to the desired public photo gallery or album.

Note:
To remove photos, open the grid view of the desired public photo gallery or an album and Right-click (Win) / Control+click (Mac) over the selection of photos to be removed. Select Remove Photo from the context menu. The selected photos are just removed, and not deleted, from the public photo gallery or album and you can still find them in All Photos.

Store an album locally
You can choose to download the photos in an album locally on your computer. Storing an album locally allows you to edit photos in that album even when your computer is not connected to the Internet. For example, when you’re traveling somewhere without Internet and want to work on your photos. Edited photos are automatically synced to the cloud whenever you’re next connected to the Internet.

1. Click the My Photos icon at the upper-left corner of the window or press P.
2. Under Albums, right-click (Win) / control+click (Mac) an album and select Store Album Locally from the context-menu.
3. A (loid) badge appears on the album thumbnail indicating that the album is now stored locally.

Share an album as a web gallery
You can make your albums public so that others can see your photos on the web. You can also select a photo or make multiple photo selections arbitrarily and share without creating an album (See Share photos as a web gallery).

To share an album, do the following:

1. Click the My Photos icon at the upper-left corner of the window or press P.
2. Under Albums, right-click (Win) / control+click (Mac) an album that you want to share and select Share Album from the context-menu.
3. In the Shared Album dialog that appears, specify the sharing preferences:

   Note:

   To modify the sharing preferences of an album that is already public, right-click (Win) / Control-click (Mac) the album and choose Share Settings from the context-menu.
Preferences

Allow downloads: Select this preference to allow others to download the shared album photos.

Show metadata: Select this preference to allow others to view metadata of the shared album photos.

Show location data: Select this preference to allow others to view location info of the shared album photos. Deselect it to hide location info.

4 Click Done.

Your album is now public.

Save photos to a computer, hard drive, or Flash drive

In Photoshop Lightroom CC, you choose to save your edited photos as JPEGs (small, maximum, or custom size) or as full-sized originals. You can save to a folder on a computer or to an attached or networked drive, such as a Flash drive.

When you save photos, you create new image files that include the edits and other metadata changes you’ve made to the photos.

To save photos from Photoshop Lightroom CC to a computer, hard drive, or Flash drive, follow these basic steps:

1 Select one or more photos to save.
   • If you’re in Photo Grid ( ) view or Square Grid ( ) view, select the photo that you want to save. Control-click to select multiple photos.
   • If you’re in Detail ( ) view, select the photo that you want to save from the filmstrip. Control-click to select multiple photos.

2 Open the Save dialog.

After selecting the photos, do any of the following:

• Click the Share ( ) icon at the upper-right corner and choose Save To from the menu that appears.
• Right-click the selected photo or the selection photos, and choose Save To from the context menu.
• From the menu bar, choose File > Save To.

3 Specify save options.
Specify save options in Photoshop Lightroom CC.

In the Save dialog box, specify the following:

**File Type**  Choose JPEG to save the photo in .JPG format. Choose Original+Settings to save the photo as full size original.

**Location**  Save at the default location or select another folder to save the photo. The default location is:
- Win: C:\Users\[user name]\Pictures\Lightroom CC Saved Photos
- Mac: /Users/[user name]/Pictures/Lightroom CC Saved Photos

**Size**  You can specify a size if you've chosen File Type as JPEG. Choose any of the following from the drop-down list:
- **Small**: Limits the length of the saved JPEG photos to 2048 pixels. The breadth is scaled accordingly to maintain the original aspect ratio.
- **Full Size**: Exports the selected photos in highest available quality in JPEG format.
- **Custom**: Applies the specified pixel value to the long edge of the photo and uses the original aspect ratio of the photo to calculate the other edge. The long edge value can't exceed 65,000 pixels.

4  **Save your photos.**
   After specifying the options, click Save.

**Share photos on Facebook**

*Note:*

You can no longer upload photos to Facebook from Lightroom CC. See this TechNote for more information.
Migrate photos and videos from Lightroom Classic CC to Lightroom CC

If you’ve used Lightroom Classic CC earlier, you’re familiar with the concept of catalogs. A catalog in Lightroom Classic CC is a database (.lrcat file) containing records for each of your photos and any videos you may have imported. A record in the catalog includes a reference to where the photo lives on your system; your instructions for processing the photo—for instance, the adjustments you applied; and photo metadata, such as keywords and ratings.

On the other hand, in Lightroom CC, your photos are stored in their full resolution centrally in the cloud, and synced with your computers and devices when you’re working on them. You can migrate your catalogs from Lightroom Classic CC to Lightroom CC. When you do so, Lightroom CC brings in each of your photos included in the catalog and uploads it to the cloud in its full resolution for access across multiple devices and computers. Later, to save on disk space, you can even consider deleting those photos from the local storage on your device.

Note:
Collections of your photos in Lightroom Classic CC automatically become albums in Lightroom CC. The following data in your Lightroom Classic CC catalog won’t be available in Lightroom CC after migration:

- Snapshots
- Custom metadata
- Creations: books, slideshows, and print/web creations
- Shares on Lightroom for the web
- Map-saved locations
- Folders and folder hierarchy
- Smart collections
- Develop history
- Color labels (migrated as keywords in Lightroom CC)

Recommended steps: Prepare for migration

Prepare your catalog in Lightroom Classic CC
Follow these steps in Lightroom Classic CC:

- **Optimize the catalog** (File > Optimize Catalog).
- Reconnect any missing files. See Locate missing photos.
• Optimize the metadata for the migration. Some tips:
  • Try creating a smart collection to find any metadata conflicts. See Create a smart collection.
  • Resolve metadata conflicts.
• Custom folder names are not migrated to Lightroom CC. As a workaround, before migrating, create collections in Lightroom Classic CC mimicking the custom folder names/structures.
• If you want to continue using Lightroom Classic CC after migration, consider upgrading to its latest version before migrating the catalog. This step makes it simpler to sync photos and metadata between Lightroom CC and Lightroom Classic CC. The original versions of any photos you import into Lightroom CC are synced back to Lightroom Classic CC.

Prepare Lightroom CC for migration
Follow these steps in Lightroom CC:
• Ensure that the Local Storage > Originals Are Currently Stored In A Custom Location preference points to the desired location. See Local storage preferences.
• Ensure that there’s enough disk space in that location to accommodate the original, full-sized images in the Lightroom Classic CC catalog. The migration process creates a copy of your images. If you’re running low on space on an internal drive on your computer, you might want to connect an external hard-drive and specify a location on it as the custom location.

Migrate a catalog
1 In Lightroom CC, select File > Migrate Lightroom Catalog.
2 In the information dialog that appears, click Continue.
3 Review the information in the Before You Begin dialog and click Continue. Before doing so, keep the following considerations in mind:
  • You can migrate a catalog only once.
• Once you migrate a catalog, Lightroom CC automatically syncs all your images to the cloud. The catalog no longer syncs in earlier versions of Lightroom, such as Lightroom 6 or Lightroom 2015. The sync functionality is available in Lightroom CC or the latest version of Lightroom Classic CC.

4 Select the catalog that you want to migrate. Then click **Start Scan**.

5 Lightroom scans the catalog and launches the migrator, displaying a progress bar for you to monitor. This step may take a while to complete.

6 (Occasional) Review any exceptions that the migrator reports. For example, the migrator might report an exception if it is unable to locate some photos included in your source catalog. In such a case, you may want to click **Migrate Later** and begin the process afresh after resolving the catalog issues in Lightroom Classic CC.

   If you want to ignore the exceptions and continue migrating, click **Continue Anyway**.

7 Review the information in the **Catalog Ready for Migration** dialog. If necessary, click **Open Log File** to inspect details. When ready, click **Start Migration**.

   Lightroom CC begins the migration process and displays a progress bar. Depending on the catalog size and the resources on your computer, this step may take a while to complete.

8 When migration is complete, Lightroom CC displays a confirmation dialog. If there are exceptions, click **Open Log File** to review the details.
Congratulations! You can edit, organize, and share your photos using Lightroom CC now.

**Migrate presets**

1. Locate your presets in Lightroom Classic CC in the following location:
   - **Mac Finder:** Macintosh HD/Users/<username>/Library/Application Support/Adobe/Lightroom/Develop Presets
   - **Windows Explorer:** C:\users\<username>\AppData\Roaming\Adobe\Lightroom\Develop Presets

2. Copy your presets to the Lightroom CC presets folder:
   - **Mac Finder:** Macintosh HD/Users/<username>/Library/Application Support/Adobe/Lightroom CC/Develop Presets
   - **Windows Explorer:** C:/users/<username>/AppData/Roaming/Adobe/Lightroom CC/Develop Presets

**Note:**

Catalog migration complete; no exceptions

Catalog migration completed with exceptions. You may see exceptions if you chose to click Continue Anyway in Step 6.
Alternatively, you can choose to move your presets. Do so only when the presets are no longer needed in Lightroom Classic CC.

3 Restart Lightroom CC.

FAQ

• Are my photos backed up in the cloud immediately after the migration is complete?

No; it may take some time to sync your original photos to the cloud. Click the icon in Lightroom CC see the sync status.

![Sync Status]

• The photos I migrated were on an external drive. Do I still need to leave it connected once the migration is complete?

Leave the external drive connected until all your photos have synced to the cloud (Sync Status: Synced And Backed Up). After the sync is complete, you can disconnect the drive and set the Local Storage > Originals Are Currently Stored In A Custom Location preference in Lightroom CC to point to a location on an internal hard-drive. Lightroom CC moves your previews files from the external hard-drive to the internal location. Your originals remain safely backed up in the cloud.

For related helpful information, see Local storage preferences.

• Can I migrate more than one catalog to Lightroom CC?

Yes; you can migrate as many Lightroom Classic catalogs (.lrcat files) as you want. The contents of each .lrcat file are added under a folder (similar to a collection set in Lightroom Classic) with that catalog's name.

More Help topics

Possible errors during migration and solutions

How Lightroom Classic CC catalogs work
Set preferences

Adjust preferences in Lightroom CC

1. To open the preferences dialog, choose Edit > Preferences (Win) or Lightroom CC > Preferences (macOS).
2. In the preferences dialog, choose any preference set from the menu at the left: Account, Local Storage, General, or Interface.
3. Set the required preferences and click Done.
4. You’ll be prompted to restart Lightroom CC to apply the settings you’ve changed. Do any of the following:
   - Click Restart to apply your settings now. Lightroom CC quits and relaunches with the updated settings applied.
   - Click Not Now to keep working in Lightroom. In this case, your changes are applied whenever you launch Lightroom CC next.

Account preferences

The Account preference set in the preferences dialog displays the account information for your Adobe ID at the top.

- **Manage Account**: Click to access your Adobe ID account online and manage the account information for your Adobe ID. For example, you can change your password and add a profile picture.
- **Cloud Storage**: Displays the space used by the photos Backed Up in the cloud and the Available Cloud Storage included with your Creative Cloud membership.
Local storage preferences

Lightroom CC intelligently manages your photos for you, so that your photos don't fill up your hard drive space. This allows you to have space available and work on the photos important to you, even if there is not enough room on your hard drive for all of your photos. You can always view all of your photos in Lightroom CC, even if the original file is not stored on your hard drive.

In the Local Storage preferences, you have the option of changing how much of your available disk space Lightroom CC is allowed to use. Originals are always backed up to the cloud. You have the options to store a copy of all originals and smart previews on your computer's hard drive as well.

Available space on  Clicking the drive name displays your Lightroom CC files in the Explorer (Win) / Finder (Mac).

Required Space  Shows how much disk space is required by the Lightroom CC database files, thumbnail images, as well as Originals and Smart Previews when you enable the options to store a copy of all Smart Previews and Originals locally.

Photo Cache  This is the amount of space reserved for storing Originals and Smart Previews that Lightroom CC manages for you.

Use Photo Cache Size Equal To % Of Your Remaining Disk Space  Enter a desired percentage value to specify how much of your available disk space Lightroom CC is allowed to use. To let Lightroom CC store more copies of your photos locally so that they are readily available for viewing and editing, increase this percentage value. If you prefer to save disk space by downloading the content when you need it, decrease the percentage value.

Store A Copy Of All Smart Previews Locally  Select to always keep all the Smart Previews on your computer's hard drive, in addition to backing them up to the cloud.

Store A Copy Of All Originals At The Specified Location  Select to always keep all the original files on your computer's hard drive, in addition to backing them up to the cloud.

Storage Location For Originals  Specify where Lightroom CC stores your Originals.

•  To change the default location or change the current custom location, click Browse, choose a folder in the (Mac) file picker window/ (Win) Select New Storage Location dialog. The new location is now displayed in the Local Storage preferences.

•  To restore a custom location to the default location, click Reset.
Store originals on a NAS (Network Attached Storage) drive

To specify a mapped network drive's path as a storage location for originals, do the following:

1. Map the NAS drive on your computer.

   (Windows)
   See Microsoft’s support documentation: https://support.microsoft.com/help/4026635/windows-map-a-network-drive

   (Mac)
   See Apple’s support documentation: https://support.apple.com/kb/PH25269

   Also see your network drive manufacturer’s documentation for additional setup information. Some help resources are provided below:

   Asustor: Windows | Mac
   Buffalo: Windows | Mac
   QNAP: Windows | Mac
   Synology: Windows | Mac
   Western: Windows | Mac

2. After you’ve mapped the network drive on your computer, open the preferences dialog in Lightroom CC.
   Choose Edit > Preferences (Win) or Lightroom CC > Preferences (macOS).

3. In the preferences dialog, choose Local Storage from the menu at the left.

4. In Local Storage preferences, click Browse next to the Storage Location For Originals preference and then choose your network drive’s path.

5. You’ll be prompted to restart Lightroom CC to apply the setting you’ve changed. Click Restart to apply your settings now.
   Lightroom CC quits and relaunches with the updated setting applied.

General preferences

General preferences in Lightroom CC
Options

Prevent System Sleep During Sync While Connected To Power  Select this option to prevent your computer from going into the sleep mode when syncing is in progress.

Use Graphics Processor  Allows Lightroom CC to use a compatible graphics processor (also called a graphics card, video card, or GPU) installed in your computer. To determine your graphics card make and model, click System Info.

Import

Add Copyright To Imported Images  Adds the specified copyright text to the metadata of images that you import after enabling this option. By default, the copyright text field displays the copyright symbol followed by your account name. If the image already has a copyright metadata, Lightroom CC doesn’t overwrite it on import. Also, the images that are already present in Lightroom CC are not affected. You can view the copyright metadata in the Info panel by clicking the ( ) icon at the lower-right corner of the screen.

Interface preferences

Interface preferences in Lightroom CC

Interface

Language  Choose your preferred language from the drop-down list.

Text Size  Choose a preferred text size to display in the Lightroom CC user interface.

Panel Tracks  Choose the Automatic or Manual option to have the panel tracks open/close automatically or manually.

Prompts

Reset All Warning Dialogs And Tips  Click Reset to restore the warning dialogs and tips displayed after you installed Lightroom CC.
Adobe Photoshop Lightroom CC for mobile and Apple TV | FAQ

Powered by the magic of Adobe Photoshop technology, Adobe Photoshop Lightroom CC for mobile lets you craft and share professional-quality images from your iPad, iPad Pro, iPhone, Android device, or Chromebook.

Adobe Photoshop Lightroom CC for Apple TV allows you to view your Lightroom photos and enjoy slideshows on your TV. It lets you swipe through your collections to quickly find the photo you're looking for or zoom in on your photos to view every detail on the big screen.

Lightroom CC for mobile

General information

- What is Adobe Photoshop Lightroom CC for mobile?
  Lightroom CC for mobile and tablets is a free app that gives you a powerful, yet simple solution for capturing, editing and sharing your photos. And you can upgrade for premium features that give you precise control with seamless access across all your devices – mobile, desktop and web.

  Craft and share pro-quality images from your smartphone or tablet using simple yet powerful tools built with Adobe Photoshop technology. Perfect your shots in a tap with more than 30 presets. Experiment with color, adjust clarity, and add vignettes.

- What features do I get for free? What additional features do I get when I purchase a Creative Cloud Photography subscription?
  You can use all the capture, organization, and sharing features in Adobe Photoshop Lightroom CC for mobile for free. You can also use most of the editing features for free.

  When you purchase a Creative Cloud Photography plan subscription you also get:
  - The ability to edit raw files and access to the Selective edits tool in Adobe Photoshop Lightroom CC for mobile.
  - The ability to sync your Lightroom photos on all your devices including your computer.
  - Photoshop CC — the world's most powerful photo-editing tool.
  - A customized website to showcase your photos powered by Adobe Portfolio.
  - The ability to access the photos you have in Lightroom in other Adobe mobile apps including Photoshop Mix, Photoshop Fix, Adobe Spark Page, Adobe Spark Video, and more.

  For additional details, see Creative Cloud Photography plans | Common questions.

  You can also try all of these for free as part of a trial for the Creative Cloud Photography plan.

- Does the mobile app work with Lightroom on my desktop?
  You can sync photos and edits between Adobe Photoshop Lightroom CC for mobile and the Lightroom Classic CC or Lightroom CC desktop app if you have an active subscription or trial for the Creative Cloud membership plans.

  For more information, see Creative Cloud Photography plans | Common questions.

  If you own a version of Lightroom with a perpetual license, you will not be able to sync photos between Lightroom on your desktop and Lightroom CC on your mobile device.
• **How can I try Adobe Photoshop Lightroom CC for mobile?**
  The best way to get Adobe Photoshop Lightroom CC for mobile is to visit the app store for your mobile device and search for "Lightroom".

• **What platforms and devices are supported by Adobe Photoshop Lightroom CC for mobile?**
  **iOS**
  Lightroom for mobile supports iOS 10 and later running on iPad Pro, iPad 4 and later, iPad Mini 2 and later, iPhone 5, iPhone 5s, iPhone 5c, iPhone 6, iPhone 6S, iPhone 6 Plus, iPhone 6S Plus, iPhone 7, iPhone 7 Plus, iPhone 8, iPhone 8 Plus, iPhone X, and iPod Touch 5th Generation.

  **Android**
  Lightroom for mobile supports phones running Android 5.x (Lollipop) and later.

  Ensure that the Android phone on which you want to install Lightroom for mobile meets the following system requirements:

  **Minimum system requirements**
  • Processor: Quad Core CPU with 1.5 GHz frequency and ARMv7 architecture
  • RAM: 1 GB
  • Internal storage: 8 GB
  • Android OS version: 5.x (Lollipop) and later

  **Recommended system requirements**
  • Processor: Quad Core CPU with 2.2 GHz frequency and ARMv8 architecture
  • RAM: 4 GB and above
  • Internal storage: 8 GB and above
  • Android OS version: 5.x (Lollipop) and later

• **Which languages is Adobe Photoshop Lightroom CC for mobile available in?**
  Adobe Photoshop Lightroom CC (iOS and Android) for mobile is available in English, French, Canadian French, German, Japanese, Italian, Spanish, Brazilian Portuguese, Korean, Russian, Simplified Chinese, Traditional Chinese, and Thai.

  Additionally, Lightroom CC for mobile (iOS) is also available in Dutch and Swedish.

• **What file formats does Adobe Photoshop Lightroom CC for mobile support?**
  Lightroom CC for mobile supports JPEG, PNG, Adobe DNG image formats. If you are a paid Creative Cloud member or have an active Creative Cloud trial you can also import and edit raw files from your camera using your iPad, iPad Pro, iPhone, Android device, or Chromebook.

  The Lightroom Classic CC and Lightroom CC desktop apps support file formats including raw images from virtually any DSLR camera, JPEG, and PNG files. Lightroom Classic CC and Lightroom CC desktop apps automatically render a smart preview of your raw photos and sync that smart preview to your mobile device. Smart previews are smaller versions of your original raw file that retain all the flexibility of a raw file at a fraction of the size.

  The original files uploaded from Lightroom Classic CC remain on your desktop and are not stored, synced, or used by Adobe Photoshop Lightroom CC for mobile. Lightroom CC desktop app uploads all your original photos to the cloud. This means that all your photos are safely backed up.
• What happens to my synced images when my Lightroom trial or subscription ends?

You maintain complete ownership of your images at all times. However, if your subscription ends, you will no longer be able to view, edit, or sync your photos in Lightroom on mobile devices. With Lightroom on your iPad, iPad Pro, iPhone, Android device, or Chromebook, you can continue to view and edit your photos for free, but you will lose access to syncing capabilities across your devices. You can continue to view and edit your photos using Lightroom Classic CC desktop.

• Does syncing images to Adobe Photoshop Lightroom CC for mobile use a portion of the cloud storage I get with my Creative Cloud membership?

Yes, images from Lightroom CC for mobile count against your cloud storage provided with Creative Cloud.

• Can Adobe Photoshop Lightroom CC for mobile be used as a backup service?

Yes, Lightroom CC automatically backs up all your photographs to the cloud and lets you access and work with your photos from any desktop or mobile device.

• Does Adobe Photoshop Lightroom CC for mobile store my original image files online?

Yes, Lightroom CC offers cloud storage and stores your all your original images in the Creative Cloud.

• How does Lightroom sync the raw files I have stored on my computer or external hard drive?

When you sync raw files from Lightroom Classic CC on your desktop to Lightroom CC for mobile, Lightroom Classic automatically renders a smart preview of your raw photos and syncs that smart preview to your mobile device. Smart previews are smaller versions of your original raw file that retain all the flexibility of a raw file at a fraction of the size.

When you upload raw files from Lightroom CC on your desktop, it automatically backs your original file to the cloud and lets you access and work with your photo from any desktop or mobile device.

• Why does use of sync with Adobe Photoshop Lightroom CC for mobile require a Creative Cloud membership?

An extensive cloud infrastructure is required to sync image data and edits between the desktop and mobile devices. Given that Creative Cloud already provides such an infrastructure, as well as a membership plan specifically for photography enthusiasts, Creative Cloud was a good fit for powering the sync of photos and edits across Adobe Photoshop Lightroom CC for mobile, desktop, and the web.

• Can I import raw files transferred to my device using the Camera Connection Kit into Adobe Photoshop Lightroom CC for mobile?

If you are a Creative Cloud member or have an active Creative Cloud trial, you have access to a Technology Preview that lets you import and edit raw files from your camera using Adobe Photoshop Lightroom CC for mobile on your iPad, iPad Pro, iPhone, Android device, or Chromebook.

• How many desktop catalogs can I sync Adobe Photoshop Lightroom CC for mobile with?

You can only sync one catalog between Lightroom Classic CC on your desktop and Adobe Photoshop Lightroom CC for mobile.

Before switching your synced catalog, ensure that all items have fully synced with your desktop Lightroom catalog.

• Does Lightroom CC on Chromebook work with a wired Internet connection?

Lightroom CC on Chromebooks does not support wired Internet connection setup via Ethernet LAN port or USB Ethernet adapter. Adobe is working to provide this support in a future version of the app. Currently, Lightroom CC on Chromebooks works with Wi-Fi and cellular data connections only.

• Does Lightroom CC for mobile use my cellular network's bandwidth when 'Use Cellular Data' option is turned off in the app settings?
When Use Cellular Data is turned on

When you enable the Use Cellular Data option in the app preferences, Lightroom CC for mobile uses your cellular network's Internet bandwidth to:

- Download an image for editing from the cloud when you open it in the Loupe view.
- Sync any image adjustments or metadata changes to the cloud.
- Upload any recently added images to the cloud.

However, if a WiFi connection is available on your mobile device, Lightroom CC for mobile prioritizes the WiFi connection over your cellular network's Internet connection.

When Use Cellular Data is turned off

When you disable the Use Cellular Data option in the app preferences and there is no network connection, Lightroom CC for mobile displays the Syncing Interrupted icon in the Albums view. In this scenario, you can choose to download the Smart Preview of an image for editing and force sync any image adjustments using your cellular network's data.

To download a Smart Preview of an image using your cellular network's data, do the following:

1. Open the image for editing in the Loupe view.
2. Tap the (!) icon at the upper-right corner and then choose Download Smart Preview.

To force sync any pending image adjustments using your cellular network's data, do the following:
1. After making adjustments to the image in the Loupe view, tap the (1) icon at the upper-right corner of the screen.
2. Tap Force Sync.

- **How can I tell if my iOS or Android mobile device supports the High Dynamic Range (HDR) capturing mode?**
  - Make sure that you are running the latest Adobe Photoshop Lightroom CC for mobile app version on your device.
  
  **(iOS)**
  
  Beginning with version 2.7, Adobe Photoshop Lightroom CC for mobile (iOS) supports HDR capture mode on any iPhone or iPad device that has at least a 12-megapixel camera, running at iOS 10.0 or newer.
  
  For more information on HDR capture mode, refer to [Capture high-contrast scenes in the HDR mode (iOS)].

  **(Android)**
  
  With the latest update, the HDR mode is available only for Samsung S8, Samsung S8+, Samsung S7, Samsung S7 Edge, Samsung Note 8, Google Pixel, Google Pixel 2, Google Pixel XL, Google Pixel 2 XL, and One Plus 5 mobile devices.

  **HDR as Technology Previews feature**: On other compatible Android mobile devices that meet the specifications listed below, the HDR mode is available as a Technology Previews feature that you can enable from the sidebar menu.
  
  - 3 GB RAM or more
  - Android OS version 6.0 (Marshmallow) or later
  - App version is 'Arm8'.
  - DNG capture is supported
  
  To check the specification for your device: In the sidebar menu, go to Device Info & Storage > Device Info.
  
  For more information on HDR capture mode, refer to [Capture high-contrast scenes in the HDR mode (Android)].

- **How can I tell if my iPhone or iPad supports capturing in the Adobe DNG format?**
  
  Beginning with version 2.5, Adobe Photoshop Lightroom CC for mobile (iOS) supports DNG raw image capture on any iPhone or iPad device that has at least a 12-megapixel camera, running at iOS 10.0 or newer.

- **How can I tell if my Android device supports capturing in the Adobe DNG raw file format?**
Beginning with version 2.0, Adobe Photoshop Lightroom CC for mobile supports DNG raw image capture on devices running Android versions 5.0 (Lollipop) and later. However, this capability is available only on those devices that support capturing DNG raw images. Support for DNG capture is enabled/set solely by the device manufacturers.

To check if your device supports DNG capture:

1. First ensure that the latest version of the Lightroom app is installed on your mobile device.
2. In the Collections view, tap ( ) icon at the upper-left corner of the screen to bring up the sidebar menu.
3. In the menu, tap Device Info & Storage > Device Info.
4. Check whether DNG Capture Supported displays Yes or No. If it displays Yes, you can capture raw images using the in-app camera.

- **How do I know if my Android phone supports the advanced editing features in Adobe Photoshop Lightroom CC for mobile?**

  Generally speaking, a newer Android phone is required to use the advanced editing features. Adobe Photoshop Lightroom CC for mobile automatically detects and gives you access to the advanced features that your phone supports. We are working on a comprehensive list of supported devices and will update this FAQ with that list as soon as possible.

- **How do I cancel my monthly Lightroom CC subscription purchased through Apple iTunes App Store or Google Play Store?**

  (iOS)

  All Lightroom CC for mobile (iOS) subscriptions that you purchase via App Store are managed by Apple through your iTunes account. You can cancel your subscription using the App Store app on your mobile device.

  For help instructions, see Apple's documentation: https://support.apple.com/en-us/HT202039

  (Android)

  All Lightroom CC for mobile (Android) subscriptions that you purchase via Google Play Store are managed by Google. You can cancel your subscription using the Google Play Store app on your mobile device.

  For help instructions, see Google's documentation: https://support.google.com/googleplay/answer/7018481

**Use Adobe Photoshop Lightroom CC for mobile**

- **How do I get started with Adobe Photoshop Lightroom CC for mobile?**

  Visit the Adobe Photoshop Lightroom CC for mobile getting started page, download the mobile app, and follow the steps.

- **How can I get help using Adobe Photoshop Lightroom CC for mobile on my devices?**

  See Work with Adobe Photoshop Lightroom CC for mobile.

**Lightroom CC for Apple TV**
General Information

• **Which versions of Apple TV hardware are supported by Adobe Photoshop Lightroom CC for Apple TV?**
  
The Adobe Photoshop Lightroom CC for Apple TV app requires an Apple TV 4th generation or newer running on tvOS 11.0 or later.

• **Why are some of my photos truncated on the left and right sides when viewing Albums?**
  
  If your picture appears cropped or truncated, adjust the zoom or overscan settings of your display device.


• **Can I edit or curate my photos in Adobe Photoshop Lightroom CC for Apple TV?**
  
  No, Adobe Photoshop Lightroom CC for Apple TV is focused on the experience of viewing your photos and videos. To edit and curate your photos, use Lightroom CC on desktop, mobile (Android and iOS), web, or Lightroom Classic on desktop.

• **Can I use a non-Apple remote with Adobe Photoshop Lightroom CC for Apple TV?**
  
  Yes, if the remote works with Apple TV, it should work with the Adobe Photoshop Lightroom CC for Apple TV app. On certain non-Apple remotes, panning around the photo while zoomed in does not work and fast scrolling may also not be available.

• **Can I add music to my slideshows in Adobe Photoshop Lightroom CC for Apple TV?**
  
  No, adding music to slideshows is not supported in Adobe Photoshop Lightroom CC for Apple TV 1.1.

  However, you may play music from another app on your Apple TV while the slideshow is running. To keep playing the background music from another app, start or pause the slideshow in Adobe Photoshop Lightroom CC for Apple TV by long pressing on the remote's touch surface.

• **Are different slide transitions available for slideshows in Adobe Photoshop Lightroom CC for Apple TV?**
  
  No, there is just one standard transition available in Lightroom CC for Apple TV.

• **What color space does Adobe Photoshop Lightroom CC for Apple TV use to show photos?**
  
  Adobe Photoshop Lightroom CC for Apple TV uses sRGB color space.

  For more information, See [FAQ | Color in Lightroom](https://support.apple.com/en-us/HT202763).

• **I’ve made changes to my photos in Adobe Photoshop Lightroom CC on the web, Adobe Photoshop Lightroom CC for mobile, or Lightroom Classic CC desktop but they aren’t showing up in Adobe Photoshop Lightroom CC for Apple TV. What can I do?**
  
  While these edits should sync automatically, if needed you can go to Settings and select Reload Albums.

• **In which languages is Adobe Photoshop Lightroom CC for Apple TV available?**
  
  Adobe Photoshop Lightroom CC for Apple TV is available in English, French, German, and Japanese.

Use Adobe Photoshop Lightroom CC for Apple TV

• **How do I get started with Adobe Photoshop Lightroom CC for Apple TV?**
  
  To set up the Adobe Photoshop Lightroom CC for Apple TV app on Apple TV, read [Set up Adobe Photoshop Lightroom CC for Apple TV app](https://support.apple.com/en-us/HT202763) and follow the steps to get the app from the App Store and sign in with your Adobe ID.

• **How can I get help using Adobe Photoshop Lightroom CC for Apple TV?**
  
  Read [View Lightroom photos on your TV](https://support.apple.com/en-us/HT202763) to learn about the app interface and settings.
More information

- Work with Adobe Photoshop Lightroom CC for mobile (iOS)
- Work with Adobe Photoshop Lightroom CC for mobile (Android)
- Setting up Lightroom Classic CC desktop to sync with Lightroom on mobile
- Access and edit Lightroom mobile photos on your computer
- Set up Adobe Photoshop Lightroom CC for Apple TV
- View Lightroom photos and videos on your TV

Feature summary | Lightroom CC | 2018 releases

The October 2017 and later releases of Lightroom CC roll out several new features and enhancements that enrich your digital imaging experience. Read on for a quick introduction to these features and links to resources offering more information.

Note:

You're viewing help for the all-new Photoshop Lightroom CC.

Not your version? View help for Photoshop Lightroom Classic CC. (Formerly Lightroom CC and Lightroom 6)

Lightroom CC v1.5 | August 2018

This release of Lightroom CC desktop rolls out new features and improvements such as storing an album locally for offline use, checking album membership of a photo, HEIC image files support on Windows, support for new cameras and lenses, and bug fixes.

Store an album locally for offline use

New in this release of Lightroom CC on desktop

Beginning with this release, you can choose to download the photos in an album locally on your computer. Storing an album locally allows you to edit photos from that album even when your computer is offline, for example, when you're traveling somewhere without Internet and want to work on your photos. Edited photos are automatically synced to the cloud whenever you're next connected to the Internet. All locally stored albums have this badge 📂 beside their names to indicate their offline availability.
Introduction

Store albums locally to edit photos from that album even when offline.

For related Help information, see Store an album locally.

**See which albums a photo belongs to**

New in this release of Lightroom CC on desktop

In the Info panel > Albums section, you can now find all the albums that your currently selected photo belongs to.

Find the albums your selected photo is in.
For related Help information, see Show which albums a photo belongs to.

HEIC image files support on Windows

New in this release of Lightroom CC on desktop
Beginning with this release, Lightroom CC now supports Apple’s HEIC image file format on Windows.
For more details, see HEIC and HEVC media files support in Lightroom and Camera Raw.

Support for new cameras and lenses

Enhanced in this release of Lightroom CC on desktop
For a full list of supported cameras and lens profiles, see these resources:
• Supported camera models
• Supported lens profiles

What’s changed

What’s changed in Lightroom CC v1.5 on desktop (August 2018 release)
• The option to individually keep photos for offline use has been removed. You can now keep photos locally at album level. See Store an album locally.
• Under Square Grid(G) view, you can now see the file extension of a photo displayed at the bottom left corner of the thumbnail.

File-extension is now displayed at the bottom left corner of the photo thumbnail in Square Grid view.

Fixed customer issues

Issues fixed in Lightroom CC v1.5 on desktop (August 2018 release)
• Lightroom CC crashing after trying to go to the Presets tab
• Unable to filter photos inside stacks
• "Show Original" key should not revert to original crop

Updates to Lightroom CC for mobile (iOS v3.4 and Android v3.6) | August 2018
iOS (iPhone and iPad)
• Improvements to organizational user interface
• Updated filter menu
• Depth map support

Last updated 10/15/2018
• Other enhancements
• Support for new cameras and lenses

Android
• Lens profile control
• HEIC file format support
• Pause and Resume sync
• Best Photos (Technology Preview)
• Guided tutorial on Watermarks
• Enhanced profile management
• Improvements to preset creation
• Ability to move presets
• Other enhancements
• Support for new cameras and lenses

**Improvements to organizational user interface**

Enhanced in this release of Lightroom CC for mobile (iOS)

This release of Lightroom CC for iOS includes a number of organizational improvements, including two new smart folders (Lr Camera Photos and Recently Added), new Shared Albums tab to see and control all of the albums shared on lightroom.adobe.com, a new multi-select mode (long tap to enter multi-select).

![Improved user interface](image)

For related information, see the following links:

• **App Interface**
• **Import and organize**
• **Save, export, and share**

**Updated filter menu**

Enhanced in this release of Lightroom CC for mobile (iOS)
With the updated filter menu, you can now filter your photos by media type, camera, location, keywords, and whether or not the photo has been edited.

For related information, see Filter photos.

**Depth map support**

New in this release of Lightroom CC for mobile (iOS)

In this release of Lightroom CC for iOS, a new technology preview feature has been added: Depth Map Support. This new tech preview adds in a new mode in Lightroom's in-app camera letting you capture HEIC photos with depth maps as well as a new selective tool that leverages depth maps captured with the Lr Camera or other capture tools. The new Depth selection tool lets you quickly turn a depth map into a selection that can be modified with a brush, that you can use the same editing tools available with other selection tools to modify your photo.
Apply selective edits using Depth Selection

For detailed information, see the following links:
- Depth capture mode (Technology Preview)
- Apply Selective edits

Lens profile control

New in this release of Lightroom CC for mobile (Android)

This release provides improvements to the Optics option in the Edit panel. You can now reduce chromatic aberration (CA) and manually select from one of the more than 1,200 Adobe-created lens profiles.
HEIC file format support

Support for HEIC image files (sometimes referred to as HEIF) has been provided in this release of Lightroom CC for mobile (Android) 3.6. You can now import, edit, and export original HEIC image files.

Pause and Resume sync

You now have the ability to pause and resume synchronization within the cloud status tab, letting you decide when you’d like to sync your photos and edits to the cloud.

Tap the cloud icon to access pause and resume options.
Introduction

Pause and Resume syncing of photos to the cloud.

**Best Photos (Technology Preview)**

New in this release of Lightroom CC for mobile (Android)

Best Photos combines Adobe Sensei smarts as well as changes and edits that you've made to your photos to make a recommend selection of your photos within an album with the highest potential, quickly and easily.

Best Photos feature can be enabled under Technology Previews in the sidebar menu.

For related helpful information, see Find best photos.
Technology Previews

We're working on some cool new features, and we're giving you a preview. Your feedback helps us improve them for you, so enable and comment on the features, below.

Notify me about new previews

Best Photos

Adds a Best Photos button within an Album, and uses machine learning to pick the best photos in an Album.

SEND FEEDBACK
Guided tutorial on Watermarks

New in this release of Lightroom CC for mobile (Android)

Introducing a new guided tutorial on using the watermark feature in Lightroom CC for mobile (Android). Use the guided, step-by-step in-app tutorial to learn how to apply watermarks to your photos. You can find guided tutorials in the Settings > Help & Support > Guided Tutorials section within the app.

For related helpful information, see Help & Support.
-guided_tutorial_on_watermarks.png

**Enhanced profile management**

Enhanced in this release of Lightroom CC for mobile (Android)

You can now manage your profiles to show or hide various profile groups that are displayed in the Profiles menu, allowing you to scan through the profiles you use the most.

For related helpful information, see [Manage profiles](#).

**Improvements to preset creation**

Enhanced in this release of Lightroom CC for mobile (Android)

You can now select only the edit settings you’ve applied to a selected photo and save it as a preset with **Auto Settings** tile option in the edit panel and **Modified** option in the **Select** panel.

For related helpful information, see [Create presets](#).

**Ability to move presets**

Enhanced in this release of Lightroom CC for mobile (Android)

You can now move a user preset to an existing preset group or to a new preset group, allowing you to organize user-created presets under groups for easy access.
For related helpful information, see Update, move, or delete presets.

**Other enhancements**

- HDR and long exposure photos captured using Lightroom's in-app camera are now greatly reduced in size, without any visual quality loss. HDR and long exposure photos are now up to 2/3rds smaller than before, taking up less space and less time to upload.

- **Sort by custom order:** You now have an option to manually reorder your grid photos. See Sorting and segmentation options.

- **Maximum photo export limit:** The limitation on maximum number of photos that can be exported, which was earlier set to 15, is now removed. For related helpful information, see Export original.

- **Auto Settings:** You can now access Auto Settings as an individual option in the Edit panel in Lightroom CC for mobile. Auto Settings, which was earlier under Light option, uses Adobe Sensei to intelligently apply adjustments based on a photo's light and color characteristics. For related helpful information, see Apply Auto Settings.

**Support for new cameras and lenses**

- For a full list of supported cameras and lens profiles, see these resources:
  - Supported camera models
  - Supported lens profiles

**Lightroom CC v1.4 | June 2018**

This release of Lightroom CC desktop rolls out new features and enhancements, support for new cameras and lenses, and bug fixes.

**Presets and Profiles syncing**

- New in this release of Lightroom CC on desktop

Beginning with this release, your Presets and Profiles (including third-party, custom user presets and profiles) now automatically sync across Lightroom CC desktop and mobile.

However, the custom user presets and profiles that you add in Lightroom CC do not sync with Lightroom Classic CC desktop.

For related Help resources, visit these links:

- Profiles
- Presets
- FAQ | Install custom, third-party Presets and Profiles in Lightroom CC

**Manage Presets and Profiles**

- New in this release of Lightroom CC on desktop

You can now choose to show or hide various preset/profile groups that are displayed in the Presets panel/Profile Browser, allowing you to scan through the profiles and presets you use the most.
Manage Profiles

To show/hide profile groups displayed in the Profile Browser, click the three-dot icon at the upper-right corner of the Profile panel and select Manage Profiles option from the pop-up menu.

Manage Presets

To show/hide preset groups displayed in the Presets panel, click the three-dot icon at the upper-right corner of the Presets panel and select Manage Presets option from the pop-up menu.

For Help documentation, visit these links:

- Manage Profiles
- Manage Presets

Copy and paste edits across multiple photos

Enhanced in this release of Lightroom CC on desktop

You can now copy the edits from a photo and paste across multiple photos.
You can also choose which edit settings to copy from a photo using the new **Choose Edit Settings To Copy** option. To access this option, select a photo and then choose **Photo > Choose Edit Settings To Copy** from the menu bar. Alternatively, press Control + Shift + C (Win) or Shift + Command + C (Mac) keys.

![Choose Edit Settings to Copy](image)

For detailed Help documentation, see **Copy and paste edits**.

**HEIC image files support on macOS High Sierra**

Promoted status: New in this release of Lightroom CC on desktop

Beginning with this release, Lightroom CC now supports Apple’s HEIC image file format on macOS High Sierra v10.13 or later.

For more details, see the TechNote **HEIC and HEVC media files support in Lightroom and Camera Raw**.

**Reset photo edits to the last opened state**

Promoted status: New in this release of Lightroom CC on desktop

You can now restore your photo edits to the state when last opened it Lightroom CC using the new **Reset To Open** option in the **Photo** menu. To reset your photo edits, you must be in **Detail** view.

1. Open the photo in **Detail** view.
2. Do one of the following:
   1. From the menu bar, choose **Photo > Reset To Open**.
   2. Press Shift + Command + R keys.

For related Help information, see **Reset Photo edits**.
**Specify share settings for a web gallery**  
New in this release of Lightroom CC on desktop

While sharing a Lightroom CC album as a web gallery, you now control the following preferences:

- **Allow Downloads**: Select this preference to allow others to download the shared album photos.
- **Show Metadata**: Select this preference to allow others to view metadata of the shared album photos.
- **Show Location Info**: Select this preference to allow others to view location info of the shared album photos. Deselect it to hide location info.

To modify the sharing preferences of an album that is already public, right-click (Win) / Control-click (Mac) the album and choose **Share Settings** from the context-menu.

For related Help information, see **Share an album as a web gallery**.

**Sort photos by File Name**  
New in this release of Lightroom CC on desktop

In this release of Lightroom CC, a new option to sort the grid photos by **File Name** has been added.

For related Help information, see **Search, filter, sort photos**.
Get Lightroom CC mobile by texting a download link to your phone

New in this release of Lightroom CC on desktop

![Get Lightroom CC mobile](image)

From Lightroom CC desktop, you can now text a link on your phone number to download Lightroom CC for mobile from Google Play/App Store.

1. From the menu bar, choose Help > Get Lightroom CC on mobile.
2. In the pop-up screen that appears, type your phone number and press Send Link.

For Lightroom CC mobile Help documentation, see:

- Work with Lightroom CC for mobile (iOS)
- Work with Lightroom CC for mobile (Android)

Support for new cameras and lenses

Enhanced in this release of Lightroom CC on desktop

For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles

Fixed customer issues

Issues fixed in Lightroom CC v1.4 on desktop (June 2018 release)

- iPhone videos play in wrong orientation
- Incorrect translation of the UI strings 'Portrait' and 'Landscape' in Adobe Raw profiles and Camera Matching profiles
- Preset and Profile import fails when there are illegal characters in the filenames
- Dehaze tool causing lag in the edit operations
- Pressing the G key toggles Guided Upright instead of Grid mode

Last updated 10/15/2018
Introduction

Hovering over a preset doesn’t display its effect when Edit panels are toggled to the off position

When trying to edit a raw file in Lightroom CC mobile, the app starts downloading the image and then freezes

Updates to Lightroom CC for mobile (iOS v3.3 and Android v3.5) | June 2018

iOS (iPhone and iPad)
- Presets and Profiles syncing
- Create and manage presets
- Healing brush
- Remove chromatic aberrations
- Capture long exposure scenes (Technology Preview)
- Guided tutorials
- What’s new information
- HEIC image original files support
- Support for new cameras and lenses
- Enable legacy presets

Android
- Presets and Profiles syncing
- Create and manage presets
- Healing brush
- Expanded HDR capture support (Technology Preview)
- Guided tutorials
- What’s new information
- Support for new cameras and lenses
- Sort photos by star rating

Presets and Profiles syncing

New in this release of Lightroom CC for mobile (iOS and Android)

Beginning with this release, your Presets and Profiles (including third-party, custom user presets and profiles) now automatically sync across Lightroom CC desktop and mobile.

However, the custom user presets and profiles that you add in Lightroom CC do not sync with Lightroom Classic CC desktop.

For related helpful information, see the following links:
- Apply profiles (iOS) | Apply profiles (Android)
- Create a user preset (iOS) | Create a user preset (Android)
- FAQ | Install custom, third-party Presets and Profiles in Lightroom CC

Create and manage presets

New in this release of Lightroom CC for mobile (iOS and Android)
You can now create custom presets in Lightroom CC for mobile to easily save your favorite edits and quickly apply in the future. You can also manage your presets to show or hide various preset groups that are displayed in the Presets menu, allowing you to scan through the presets you use the most.

For related helpful information, see the following links:

- Create a user preset (iOS) | Create a user preset (Android)
- Manage presets (iOS) | Manage Presets (Android)

**Healing brush**

New in this release of Lightroom CC for mobile (iOS and Android)

Use the Healing Brush tools to remove unnecessary spots, power lines, people, objects, or other such distractions from a photo.

(Screenshot from an Android device) Access the Healing Brush tools.
(Screenshot from an iOS device) Using the Heal tool to remove the unwanted object from the photo (the person, in this case). A Heal  B Clone  C Size  D Feather  E Opacity  F Delete  G Target area  H Source area  I Hide screen controls to view the photo edits

For related helpful information, see the following links:

• Remove unwanted spots and objects (iOS)
• Remove unwanted spots and objects (Android)

Remove chromatic aberrations

+ New in this release of Lightroom CC for mobile (iOS)

In Lightroom CC for mobile (iOS), turn on the new Chromatic Aberration option to automatically correct blue-yellow and red-green fringes in your image. To access this option:

• (iPhone) In the Edit panel in the Loupe view, tap the Optics icon at the bottom of the screen.
• (iPad) In the Edit panel menu in the Loupe view, tap the Optics accordion.

For related helpful information, see Correct camera lens flaws automatically.

Capture long exposure scenes (Technology Preview)

+ New Technology Preview feature in this release of Lightroom CC for mobile (iOS)
In Lightroom CC for mobile (iOS), use the in-app camera to capture long exposure scenes without a tripod. In this mode, the camera takes multiple images and blends them together for a long exposure effect.

**Note:**

The Long Exposure Technology Preview feature has been introduced for iPhone 7, 7+, 8, 8+, and X models only. You can enable this feature under Technology Previews in the app Settings menu.

![iPhone X Capture interface options in the Long Exposure mode.](image)

**Expanded HDR capture support (Technology Preview)**

A new Technology Preview feature in this release of Lightroom CC for mobile (Android)

You can now enable the HDR capture mode on compatible Android devices that have not yet been officially tested and verified. On Android mobile devices that meet the specifications listed below, the HDR mode is available as a Technology Previews feature that you can enable from the app Settings menu.

- 3 GB RAM or more
- Android OS version 6.0 (Marshmallow) or later
- App version is ‘Arm8’
• DNG capture is supported

For related helpful information, see Capture high-contrast scenes in the HDR mode.

Guided tutorials

New in this release of Lightroom CC for mobile (iOS and Android)

Learn how to use Lightroom CC for mobile with the step-by-step, interactive tutorials.

In the app Settings menu in Lightroom CC (iOS and Android), tap Help & Support > Guided Tutorials.

Note:

In Lightroom CC (iOS), the Guided Tutorials feature has been introduced as a Technology Preview. In the app settings, you need to first switch on Guided Tutorials under Technology Previews to access the tutorials from the Help & Support menu.

For more information, see the following links:

• App preferences and options (iOS)
• App preferences and options (Android)

What’s new information

New in this release of Lightroom CC for mobile (iOS and Android)

In the app Settings menu, use the What's New dialog to view a chronological list of fixes and improvements made in the app.

For more information, see the following links:

• App preferences and options (iOS)
• App preferences and options (Android)

HEIC image original files support

New in this release of Lightroom CC for mobile (iOS)

Beginning with this release, Lightroom CC iOS now backs up Apple's HEIC image files in the original file format.

For more details, see the TechNote HEIC and HEVC media files support in Lightroom and Camera Raw.

Sort photos by star rating

New in this release of Lightroom CC for mobile (Android)

In Lightroom CC for mobile (Android), you can now sort your grid photos by the number of stars.

For more details, see Sorting and Segmenting options.

Enable legacy presets

New in this release of Lightroom CC for mobile (iOS)

In Lightroom CC for mobile (Android), you can use the Manage Presets option to enable the legacy Lightroom preset groups, which are hidden by default.

For related helpful information, see Manage presets (iOS).
Support for new cameras and lenses

🎉 Enhanced in this release of Lightroom CC for mobile (iOS and Android)

💡 For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles

Lightroom CC v1.3 | April 2018

This release of Lightroom CC desktop rolls out new features, support for new cameras and lenses, and bug fixes.

New Adobe Raw and creative profiles

🎉 New in this release of Lightroom CC on desktop

Profiles allow you to control how colors and tonality are rendered in your photos. The profiles provided in the new Profile panel are intended to serve as a starting point or foundation for making image edits.

For raw photos, you can choose one of the Adobe Raw profiles to set a precise foundation for your edits or one of the available Camera Matching profiles to match the appearance of the photos as you see on your camera’s screen. For both raw and non-raw photos, you can create a unique style or effect in your photo by choosing any of the creative profiles grouped under Artistic, B&W, Modern, and Vintage.

Applying a profile on your photo doesn’t change or overwrite the value of other edit control sliders. Therefore, you can make edits to your photos as you like and then choose to apply a profile on top of your edited image.

1 If you’re in Photo Grid (▲) view or Square Grid (▲) view, select a photo that you want to edit. Now, click (▲) icon in the toolbar at the bottom to switch to Detail view.

If you’re already in Detail (▲) view, select a photo that you want to edit from the filmstrip appearing at the bottom of your current selection.
2 Click (>>) icon at the upper-right corner to bring up the Edit panel. Locate the new Profile panel at the top and click Browse.

Browse profiles in the new Profile panel

3 Expand any profile group to reveal its profiles.

Profile groups for a raw photo
Introduction

Adobe Raw profiles

Move the pointer over any profile to preview it on your photo.
Click any profile to apply it to your photo.

For detailed Help documentation, visit these links:

- Profiles
- Browse and apply profiles
- Add a profile to Favorites
- Import profiles

Support for NAS (Network Attached Storage) disk drives

With the support for NAS disk drives in Lightroom CC, you can now choose to store a copy of all the originals on a mapped network drive. To do so:

1. First, map the NAS drive on your computer. Refer to your network drive manufacturer’s documentation.
2. After you’ve mapped the network drive on your computer, open the preferences dialog in Lightroom CC. Choose Edit > Preferences (Win) or Lightroom CC > Preferences (macOS).
3. In Local Storage preferences, click Browse next to the Storage Location For Originals preference and then choose your network drive's path.
4. Restart Lightroom CC.

For detailed information and Help resources, see Store originals on a NAS (Network Attached Storage) drive.

Filter by Sync Status

New in this release of Lightroom CC on desktop

Last updated 10/15/2018
In this release of Lightroom CC, a new filter has been added - **Sync Status**.

![Sync Status filter](image)

To access this filter:

1. Click the filter ( ![ ] ) icon next to the search bar at the top of the screen.
2. Click the **Sync Status** filter and choose any filter option from the drop-down list to filter photos based on their sync status.
   - **Syncing**: Displays photos whose edits or changes are currently syncing to the cloud.
   - **Synced and Backed Up**: Displays photos whose originals are synced and backed up to the cloud.
   - **Original Stored Locally**: Displays photos whose originals are stored on your machine.
   - **Synced From Lightroom Classic**: Displays photos whose originals are not available or backed up to the cloud, but a smart preview is available.

For related helpful information, see **Rate and flag photos**.

**Support for new cameras and lenses**

- ![ ] Enhanced in this release of Lightroom CC on desktop
- ![ ] For a full list of supported cameras and lens profiles, see these resources:
  - Supported camera models
  - Supported lens profiles

**Fixed customer issues**

Issues fixed in Lightroom CC v1.3 on desktop (April 2018 release)

- ![ ] Initial sync with a large number of albums can get stuck before showing or loading any images
- ![ ] Ability to expand or collapse all the albums at once
- ![ ] Lightroom CC applies some harsh filter on 'Save To JPG'

**Updates to Lightroom CC for mobile (iOS v3.2 and Android v3.4) | April 2018**

**iOS (iPhone and iPad)**

- Premium feature
  - Fix and adjust perspective in your photos

**Other features and enhancements**

- New Adobe Raw and creative profiles
- Add film-grain effect to your photos
- Enhanced control over Lightroom CC web shares
- Left-handed editing mode (iPad-only) (iPad only)
Support for new cameras and lenses

iPhone X layout optimization (iPhone only)

Bug fixes

Android

New Adobe Raw and creative profiles

Add film-grain effect to your photos

Apply sharpening and noise reduction

Enhanced control over Lightroom CC web shares

Support for new cameras and lenses

Bug fixes

Fix and adjust perspective in your photos

New Premium feature in this release of Lightroom CC for mobile (iOS)

While capturing photos, a close distance to the subject as well as certain types of lenses can distort perspective and make straight lines appear bowed, tilted or skewed in your photos. For example, shooting up at a tall building can make the building look like it’s leaning away from you. You can easily fix and adjust the perspective of your photo using the Upright modes and geometry slider tools in the Geometry panel.

The Upright mode provides four automatic perspective correction options - Auto, Level, Vertical, and Full, as well as a manual Guided option. You can also refine the adjustment using the geometry sliders.
Upright modes in Lightroom CC for mobile iOS
For Help documentation, see Fix geometric perspective in photos.

New Adobe Raw and creative profiles

In this release of Lightroom CC for mobile (iOS and Android), new Adobe Raw and creative have been introduced. Profiles allow you can now control how colors and tonality are rendered in your photos. They are intended to serve as a starting point or foundation for making image edits.

For raw photos, you can select one of the new Adobe Raw profiles to set a precise foundation for your edits. To match the appearance of the photos created by your camera, you can use one of the available Camera Matching profiles. For both raw and non-raw photos, use the new Creative Profiles to add a unique style, while adjusting the effect with a new amount slider.

Applying a profile on your photo doesn't change or overwrite the value of other edit control sliders. Therefore, you can make edits to your photos as you like and then choose to apply a profile on top of your edited image.

For details, see the following links:

- Apply profiles (iOS)
- Apply profiles (Android)
Add film-grain effect to your photos

New in this release of Lightroom CC for mobile (iOS and Android)

In this release of Lightroom CC for mobile (iOS and Android), a new Grain slider control has been added in the Effects panel. When editing your photos, use this slider to add photographic-film grain effect. You can also control the grain size and roughness.

For details, see the following links:

- Apply effects (iOS)
- Apply effects (Android)

Apply sharpening and noise reduction

New in this release of Lightroom CC for mobile (Android)

In this release of Lightroom CC for mobile (Android), new sharpening controls, luminance noise and color noise reduction controls have been introduced in the Details panel.

For detailed information, see Adjust noise reduction and sharpening.

Enhanced control over Lightroom CC web shares

Enhanced in this release of Lightroom CC for mobile (iOS and Android)

In this release of Lightroom CC for mobile (iOS and Android), you can now specify the following sharing options while sharing an Album as a Web Gallery.

- **Author**: Specify the author name to be displayed in the metadata of the shared album photos. This option is available on Android devices only.
- **Show Metadata**: Turn on to allow others to view metadata of the shared album photos. Turn off to hide metadata.
- **Show Location Info**: Turn on to allow others to view location info of the shared album photos. Turn off to hide location info.
- **Allow Downloads**: Turn on to allow others to download the shared album photos. Turn off to disable downloads.

For details, see the following links:

- Share web albums (iOS)
- Share web albums (Android)

Left-handed editing mode (iPad-only)

New in this release of Lightroom CC for mobile (iPad-only)

A new preference setting Left Handed Editing has been introduced that allows you have the Edit controls and panels on the left edge of your iPad’s screen.

To access this setting in Lightroom CC on your iPad, go to Settings > General > Left Handed Editing.

Support for new cameras and lenses

Enhanced in this release of Lightroom CC for mobile (iOS and Android)

For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles
**Lightroom CC v1.2 | February 2018**

This release of Lightroom CC desktop rolls out a new import preference to add copyright to the metadata of imported images, support for new cameras and lenses, and bug fixes.

**Add copyright metadata to imported images**

New in this release of Lightroom CC on desktop

In this release of Lightroom CC, a new option has been added in the preferences - **Add Copyright To Imported Images**. To access this option, choose **Edit (Win)** or **Lightroom CC (macOS) > Preferences > General**.

![General preferences in Lightroom CC](image)

When you enable this option, Lightroom CC adds the specified copyright text to the metadata of images that you import subsequently. By default, the copyright text field displays the copyright symbol followed by your account name. If the image already has the copyright metadata, Lightroom CC doesn't overwrite it on import. Also, the images that are already present in Lightroom CC are not affected.

For Help documentation, visit these links:

- **General preferences**
- **View photo metadata**

**Support for new cameras and lenses**

Enhanced in this release of Lightroom CC on desktop

For a full list of supported cameras and lens profiles, see these resources:

- **Supported camera models**
- **Supported lens profiles**

**What's changed**

In the **Preferences** dialog (**Edit (Win)/Lightroom CC (macOS) > Preferences**), the options listed below have been moved from the **General preferences** set to the new **Interface preferences** set.

- Language
- Text Size
- Panel Tracks
- Reset All Warning Dialogs And Tips
Fixed customer issues
Issues fixed in Lightroom CC v1.2 on desktop (February 2018 release)

- The Highlights slider control under Vignette is not functioning. (Windows-only)
- Error message when trying to open an image by dragging it to the Lightroom CC icon pinned in the taskbar. (Windows-only)
- 'Keep Original Available Locally' does not always respond when multiple images are selected in the grid.
- While importing photos or videos, MTS video previews in the grid appear blurry or blank.
- Videos are missing the camera make/model metadata in the Info panel.
- Migration to Lightroom CC fails if the storage drive location doesn’t have read/write permission. See this TechNote for a workaround.
- In Detail view, the Edit Capture Time dialog (Photo > Edit Date & Time) displays a spinning wheel icon while the Info panel is closed; you are unable to edit the capture time.
- Error when launching Lightroom CC: Unable to setup WF RTMFP Notify Pipe.
- 'Send to Facebook' should upload a larger photo, which is currently limited to 960 pixels long-edge JPEG.

Updates to Lightroom CC for mobile (Android v3.3 and iOS v3.1.1) | February 2018

Android

Premium feature
Fix and adjust perspective in your photos

Other features and enhancements
- Add watermark during export
- Import photos using the Files option
- Add to Lightroom from third-party photo apps
- Use Google Assistant to search Lightroom photos
- Sort by import date in the All Photos view
- Support for new cameras and lenses
- Bug fixes and speed improvements

iOS (iPhone and iPad)

- Support for new cameras and lenses
- Bug fixes and speed improvements

Fix and adjust perspective in your photos
- New Premium feature in this release of Lightroom CC for mobile (Android)
Introduction

While capturing photos, a close distance to the subject as well as certain types of lenses can distort perspective and make straight lines appear bowed, tilted or skewed in your photos. For example, shooting up at a tall building can make the building look like it’s leaning away from you. You can easily fix and adjust the perspective of your photo using the Upright modes and geometry slider tools in the Geometry panel.

The Upright modes provides four automatic perspective correction options - Auto, Level, Vertical, and Full, as well as a manual Guided option. You can also refine the adjustment using the geometry sliders.

*Upright modes in Lightroom CC for mobile Android*
Introduction

Two vertical and two horizontal guides drawn on the photo using Guided Upright

For Help documentation, see Fix geometric perspective in photos.

Add watermark during export

New in this release of Lightroom CC for mobile (Android)

You can now add a customizable text watermark while sharing your photos and while saving photos to your mobile device.
Import photos using the Files option

New in this release of Lightroom CC for mobile (Android)

Using the new Files option in Lightroom CC for mobile, you can access Android's file-manager to import photos from various sources:

- Other supported photo apps and cloud-based apps installed on your device, such as Google Photos, Google Drive, and Dropbox.
- A DSLR camera connected to your mobile in PTP mode via USB OTG cable.
- Another plugged-in device connected to your mobile via USB.
- Your device's folders

To import using the Files option, do the following:

1. While in the Albums view, tap the three-dot (…) icon on the All Photos album or any other album where you want to add photos. Then, choose Add Photos from the pop-up menu. While viewing photos within any album that you've created, tap the Add Photos icon at the lower-right corner of the screen.

2. In the Add Photo From context-menu that appears at the bottom of the screen, choose Files.
Accessing the Files option from the Albums view
Add to Lightroom from third-party photo apps

You can now add photos to Lightroom CC for mobile from other third-party photo apps that have the share capability, such as Google Photos, Google Drive, and Dropbox.

To do so, simply select photos in any other photo app, share them, and choose the Add To Lr option. Your photos are added to the All Photos album in Lightroom CC for mobile.
Add To Lr option when sharing from Google Photos

Note:

To view your recently imported photos, go to the All Photos album. In the All Photos view, tap the three-dots (・・・) icon at the upper-right corner of the screen and choose Sort By Import Date. Your recent imports now appear at the top.

For more information, see Add to Lightroom from third-party photo apps.

Use Google Assistant to search Lightroom photos

New in this release of Lightroom CC for mobile (Android)

Note:

Searching photos within Lightroom CC using Google Assistant requires an active Internet connection. This capability is currently supported in English language only.

In the Google Assistant search bar, type or tap the mic and say:

Search <your search keyword> in Lightroom

For example, you can quickly search for all photos within Lightroom CC that have mountains in them by typing or speaking - Search mountains in Lightroom.
Search Lightroom photos using Google Assistant
Lightroom CC for mobile displaying the search result

For related information, see Search Lightroom photos using Google Assistant.

Sort by import date in the All Photos view

Enhanced in this release of Lightroom CC for mobile (Android)

In the All Photos view, you can now view your recently imported photos by tapping the three-dots (…) icon at the upper-right corner of the screen and then choosing Sort By Import Date.

Your recent imports will appear at the top.

Support for new cameras and lenses

Enhanced in this release of Lightroom CC for mobile (Android and iOS)

For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles

Lightroom CC for Apple TV v1.2 | December 2017

Support for folders, search, filtering, and sorting

New in this release of Lightroom CC for Apple TV

For Help documentation, visit these links:

- Albums
- Search
- Sort or filter your photos and videos

Lightroom CC v1.1 | December 2017

This release of Lightroom CC desktop rolls out new features and enhancements, support for new cameras and lenses, and bug fixes.

Enhanced 'Auto' to automatically apply the best edits in your photos

Enhanced in this release of Lightroom CC on desktop

Last updated 10/15/2018
Start your edits with Auto, which uses Adobe Sensei to intelligently apply adjustments based on a photo’s light and color characteristics. Adobe's Auto feature now uses advanced machine learning to automatically apply the best edits for these slider controls in your photos: Exposure, Contrast, Highlights, Shadows, Whites, Blacks, Saturation, and Vibrance. In addition, the Auto feature now also includes the ability to optimize the adjustments of the photo even after cropping has been applied.

The underlying neural nets have been trained with thousands of professionally shot and manually edited photos to evaluate and correct an image, just like a skilled human photographer.

The Auto option is located in the Light panel in the Detail view.

For related details, see Edit photos.

To know more about Adobe's machine learning capabilities, see Machine learning FAQ.

Use Tone Curve to fine-tune the tonal range and contrast in your photo

New in this release of Lightroom CC on desktop

The Tone Curve in the Light panel gives you greater control over the tonal range and contrast in your photo. To bring up the Tone Curve graph, switch to the Detail view ( ) and click the ( ) icon in the Light panel.
For more details, see Fine-tune the tonal scale using the Tone Curve.

Create a split tone effect in your photo

New in this release of Lightroom CC on desktop

Using the Split Toning controls in the Effects panel, create a split tone effect in which a different color is applied to Shadows and Highlights in your photo. For example, you can color a monochrome photo or apply special effects, such as a cross-processed look, to a color photo.

To view the Split Toning controls, switch to the Detail ( Detail) view and click the ( Split Tone) icon in the Effects panel.
Introduction

Split tone effect created on a monochrome image.

For more details, see Split Toning.

**Edit photo capture date and time**

New in this release of Lightroom CC on desktop

You can now adjust the date and time of an individual photo or a group of photos. This feature is useful in scenarios where you need to change the capture time for your photos after clicking them.

For example, you might need to change the capture times if you traveled to a different time zone and didn't change your camera's date/time setting before you started photographing. Another scenario could be that you added a scanned photo to Lightroom CC and want the capture time to show the date on which the image was photographed rather than the date on which it was scanned.

![Shift Date Range dialog](image)

*Shift Date Range dialog | Adjusting the capture date and time of a group of photos.*

**Note:**

See known issue: Edit Date & Time dialog does not load.

For more details, see Change photo capture time.

**View photos on full screen**

New in this release of Lightroom CC on desktop

Last updated 10/15/2018
Introduction

While in the Detail view ( ), you can enter the full-screen mode by pressing F key or choosing View > Detail - Full Screen from the menu bar. While viewing your photos in the full-screen mode, you can cycle through your album photos and also rate and flag them.

For more details, see View photo on full screen.

Support for new cameras and lenses

- Enhanced in this release of Lightroom CC on desktop
- For a full list of supported cameras and lens profiles, see these resources:
  - Supported camera models
  - Supported lens profiles

Fixed customer issues

Issues fixed in Lightroom CC v1.1 on desktop (December 2017 release)

- Improved performance when applying keywords to a large number of images
- Improvements to the local storage preferences.
- Image thumbnail in the Filmstrip refreshes quicker when applying adjustments
- Improved speed when migrating your Lightroom Classic CC catalog to Lightroom CC
- Fixed the Lightroom CC hanging issue when importing a large number (5000+) of photos/videos
- Fixed the issue Lightroom CC doesn’t allow importing two photos with the same name; the Import dialog displays that the image has already been imported.
- Updated the migration log to accurately display the amount of local storage required for migrating a Lightroom Classic CC catalog to Lightroom CC
- Fixed the issue Lightroom CC crashes when opening the preferences dialog (macOS v10.13 High Sierra-only)
- Fixed the issue Lightroom CC migration fails with non-informative error message as reported here and here.

Updates to Lightroom CC for mobile (iOS v3.1 and Android v3.2) | December 2017

iOS (iPhone and iPad)

- New Auto Settings
- Add watermark during export
- Support for new cameras and lenses
- Improved quality to HDR capturing
- Language support for Dutch and Swedish
- Bug fixes and speed improvements

Android

- New Auto Settings
- App shortcuts
- More control for managing storage
- Use Cellular Data setting
- Bug fixes and speed improvements

Last updated 10/15/2018
New Auto Settings

New in this release of Lightroom CC for mobile (iOS and Android)

(Android) Auto Settings
Start your edits with **Auto**, which uses Adobe Sensei to intelligently apply adjustments based on a photo’s light and color characteristics. Adobe’s **Auto** feature now uses advanced machine learning to automatically apply the best edits for these slider controls in your photos: **Exposure, Contrast, Highlights, Shadows, Whites, Blacks, Saturation**, and **Vibrance**. In addition, the **Auto** feature now also includes the ability to optimize the adjustments of the photo even after cropping has been applied.

The underlying neural nets have been trained with thousands of professionally shot and manually edited photos to evaluate and correct an image, just like a skilled human photographer.

For details, see the following links:

- Apply Auto Settings (Android)
- Apply Auto Settings (iOS)

**Add watermark during export**

New in this release of Lightroom CC for mobile (iOS)
You can now add a customizable text watermark while sharing your photos and while saving your photos to camera roll.

For Help documentation, see Add a text watermark while sharing or saving your photos.

**Support for new cameras and lenses**

For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles

**Add shortcuts**

New in this release of Lightroom CC for mobile (Android)
The app shortcuts feature has now been added for devices running Android versions 7.1.1 or later. However, the support for this feature on your Android device is enabled/set solely by the mobile device manufacturer.

On your device’s home screen, long press on the Lightroom CC app icon to access the following shortcuts:

- **Selfie**. Launches the in-app camera module with your device’s front camera.
- **Lightroom Camera**. Launches the in-app camera module with your device’s back camera.
- **Add Photos**. Launches the import interface where you can select and add images from device’s photo gallery.

To access the app shortcuts, you need to launch the Lightroom CC app at least once.

For Help documentation, see **App shortcuts**.

**More control for managing storage**

In the **Device Info & Storage** settings, you can now use the **Manage Storage** option to view a list of all the albums for which you’ve enabled the **Store Locally** album option and release locally stored copies and free up space on your device; the originals are still backed up in the cloud.

When you clear or purge the offline content of a locally stored album, Lightroom CC for mobile removes cache files stored for offline use in that album. Any images in the album that also marked for offline use in another locally stored album are not removed. Your images remain in the album and are not deleted.

For more information, see **App preferences and options**.

**Lightroom CC v1.0.1 | November 2017**

Adobe recently released the all-new Lightroom CC app on desktop in October 2017. To learn more, read [this blog post](#).
Lightroom CC v1.0.1 rolls out bug fixes and performance improvement.

**Fixed customer issues**

Issues fixed in Lightroom CC v1.0.1 on desktop (November 2017 release)

Lightroom CC crashes when opening the preferences dialog (macOS v10.13 High Sierra-only).

For Lightroom CC Help resources and documentation, see the following links:

- Lightroom CC Get Started
- Lightroom CC | Common questions
- Creative Cloud Photography plans | Common questions
- Lightroom CC | Known issues and workaround

**Updates to Lightroom CC for mobile (iOS v3.0 and Android v3.1) | October 2017**

iOS (iPhone and iPad)

Premium features

- Find photos using the intelligent online search
- Organize albums into folders
- Assign keywords to your photos

Android

Premium features

- New Brush Selection tool to apply selective edits
- Find photos using the intelligent online search
- Organize albums into folders
- Assign keywords to your photos

Other Enhancements

- Optimized for iOS 11
- Import and export to iOS v11 Files
- Support for High Efficiency Image File (HEIF) file import
- Drag and drop from other applications into Lightroom CC (iPad only)
- Pause and resume app synchronization when it's convenient for you. Pause and resume syncing
- Bug fixes and speed improvements

Other Enhancements

- Optimized for the new Google Pixelbook
- HDR capture support for Samsung Note 8 and One Plus 5. Support for HDR on Samsung Note 8 and One Plus 5 mobile devices
- Export original. Learn more
- New Presets. Learn more
- Bug fixes and speed improvements

**New Brush Selection tool to apply selective edits**

New in this release of Lightroom CC for mobile (Android)

In the Selective edit controls, the new Brush Selection tool lets you select specific parts of an image by brushing over them and apply adjustments such as Exposure, Clarity, Brightness, and other.
Apply selective edits using the Brush Selection tool
A Brush  B Eraser  C Size  D Feather  E Flow

For more details about the Brush Selection tool, see Apply Selective edits (Android).

Find photos using the intelligent online search

New in this release of Lightroom CC for mobile (iOS and Android)
You can find your photos within an album or All Photos view using the Search bar at the top. Aside from searching photos by metadata and keywords, Lightroom CC for mobile can now find and display photos based on the objects in them.

For example, you can quickly search for all photos that have "mountains" in them.

For details, see the following links:

- Search photos (Android)
- Search photo (iOS)

**Organize albums into folders**

New in this release of Lightroom CC for mobile (iOS and Android)

You can now organize your photo albums into a folder hierarchy. The nested levels help you keep your photos and albums better organized.
Introduction

(Android) Albums view
Introduction

(iOS) Albums organized into a folder
For details, see the following links:

- Create an album and add photos and Organize albums into folders (Android).
- Create an album and add photos and Organize albums into folders (iOS).

Assign keywords to your photos

New in this release of Lightroom CC for mobile (iOS and Android)

iOS

The new Keywords panel in the Loupe view allows you to assign keywords to your photos. You can also copy keywords assigned to a photo and paste it to another photo.

Android

In the Loupe view, use the Keywords section at the bottom in the Info panel to assign keywords to your photos.

Note:

- Keywords sync with Lightroom CC across all your devices.
- Keywords do not sync with the Lightroom Classic CC desktop app.
Introduction

For details, see the following links:

- Info panel (Android).
- Keywords panel (iOS).

Support for HDR on Samsung Note 8 and One Plus 5 mobile devices

Enhanced in this release of Lightroom CC for mobile (Android)

In this release of Lightroom CC for mobile Android, support for HDR mode has been added on Samsung Note 8 and One Plus 5 models.

With the latest update, the HDR mode is now available for Samsung S8, Samsung S8+, Samsung S7, Samsung S7 Edge, Samsung Note 8, Google Pixel, Google Pixel XL, and One Plus 5 mobile devices.

For more details about the HDR capture mode, see Capture high-contrast scenes in the new HDR mode (Android).

Pause and resume syncing

Enhanced in this release of Lightroom CC for mobile (iOS)
In Lightroom CC for mobile (iOS), you can now pause and resume app synchronization when it's convenient for you.

- To pause syncing, tap the cloud (/weather) icon at the upper-right corner and select Pause Syncing from the context-menu. The cloud icon changes to indicate that the syncing is paused.
- To resume syncing, tap the cloud icon again and choose Resume Syncing from the context-menu.

Migrate Apple Photos Library to Lightroom CC

**Prepare Apple Photos Library for migration**

Ensure that the Apple Photos Library you want to migrate is set as the Systems Photos Library. To set your library as the Systems Photos Library, follow these steps:

1. Open Apple Photos and select Preferences in the menu bar.
2. Click the General tab and select Use as System Photo Library under Library Location.
Select Use as System Photo Library. If it is grayed out, then it is already set as the System Photos Library.

**Note:**

- If Use as System Photos Library is grayed out, then the library is already set as System Photos Library.
- If you want to migrate the assets synced to your iCloud Library, click the iCloud tab and select **iCloud Photo Library**.
- Ensure that Download Originals to this Mac is selected, as the Photos migrator can migrate photos for which Originals are stored locally. Wait for all your originals to be downloaded before you begin migration.

Select **iCloud Photo Library** to migrate assets that are synced to iCloud Library. Select **Download Originals to this Mac** to allow migration of originals.
Before you begin migration

A Photos Library can be migrated to Lightroom CC only once. You can, however, migrate additional libraries. Also consider the following before you begin migration to Lightroom CC:

- **Supported macOS versions**
  The migration of Apple Photos Library to Lightroom CC is supported in the following operating systems:
  - macOS 10.12 (Sierra)
  - macOS 10.13 (High Sierra)
  - macOS 10.14 (Mojave)
  
  **Note:**
  In macOS 10.12 (Sierra), HEIC file formats are not supported.

- **What gets migrated to Lightroom CC?**
  - **Folders and Albums**
    - The hierarchy of folders and albums in Apple Photos Library is migrated to Lightroom CC. Shared albums and corresponding assets can also be migrated to Lightroom CC. Ensure that you select iCloud Photo Sharing to receive Shared albums data in your Photos Library.
  
  - **Bursts**
    - Currently only the keyframe is migrated
    - If you want all the Burst photos to be migrated, unstack them in Apple Photos first and then migrate them. To unstack and select Burst photos for migration, see View photo bursts and select shots to work with in this Apple document. After you’ve done this, the desired Burst photos will appear in your Photos Library which you can then migrate.
  
  - **Live Photos**
    - The rendition of the still keyframe is migrated
    - The video is migrated
  
  - **Raw**
    - Only the untouched original is migrated
  
  - **Portrait/Depth Effect**
    - The untouched original is migrated
  
  - **People**
    - Tagged people are migrated to Lightroom CC
  
  **Note:**
  - For Live Photos, since both the video and image components are migrated, the photo count in Lightroom CC is higher than what is shown in Apple Photos.

- **What is not migrated to Lightroom CC?**
  - The following assets are not migrated to Lightroom CC:
    - Assets in Hidden Album
    - Assets in the Recently Deleted Folder
    - Assets in iCloud but not stored locally
Introduction

- **Raw**
  - The edits made to raw images are not migrated

- **Portrait/Depth Effect**
  - The depth effect image is not migrated

- **People**
  - Face data for images that are cropped or rotated are not migrated. However, the unmodified original is migrated.

- **Animated Live Photo Effects**
  - Loop, Bounce, and Long Exposure effects are not migrated.

- **Expected migration behavior of various HEIC media types**

  If you are using macOS 10.12 (Sierra) and have HEIC assets in your library, the HEIC assets are not migrated to Lightroom CC.

  If your library has HEIC assets, Apple Photos runs a background task to process these photos for migration. After the processing is complete, all the HEIC assets are ready for migration.

  - In case the migration is executed before the processing of all assets is complete, few assets are not migrated to Lightroom CC.
  
  - If all assets are not ready for migration, you can view a dialog box that states that all the assets are not migration-ready.

<table>
<thead>
<tr>
<th>HEIC media type</th>
<th>Migration behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Photos</td>
<td>HEIC (unmodified original still image) and H.265 MOV (video) are migrated.</td>
</tr>
<tr>
<td>Animated Live Photos - Loop and Bounce</td>
<td>HEIC (unmodified original still image with no effect) is migrated. Animated effect (Loop and Bounce) is not migrated.</td>
</tr>
<tr>
<td>Animated Live Photos - Long Exposure</td>
<td>HEIC (unmodified original still image with no effect) is migrated. Image rendition of Long Exposure effect is not migrated.</td>
</tr>
<tr>
<td>Edited Live Photos (where the keyframe is changed)</td>
<td>HEIC (unmodified original still image) and H.265 MOV (video) are migrated.</td>
</tr>
<tr>
<td>Portrait/Depth Effect</td>
<td>HEIC (unmodified original with no effect) is migrated. JPG rendition of the Portrait/Depth Effect is not migrated.</td>
</tr>
<tr>
<td>Edited Portrait/Depth Effect</td>
<td>HEIC (unmodified original with no effect) is migrated. JPG rendition of the Portrait/Depth Effect is not migrated.</td>
</tr>
<tr>
<td>Bursts</td>
<td>Only keyframe is migrated. The burst sequence of photos is not migrated.</td>
</tr>
<tr>
<td>Still (non-Live Photos)</td>
<td>Still images are migrated.</td>
</tr>
<tr>
<td>Panoramas</td>
<td>Panoramas are migrated.</td>
</tr>
<tr>
<td>Squares</td>
<td>Square images are migrated.</td>
</tr>
</tbody>
</table>
Start migration

Note:

- In Lightroom CC, ensure that Local Storage > Originals Are Currently Stored In A Custom Location preference points to the desired location to store the migrated Apple Photos Library. To know more, see Local storage preferences.
- An Apple Photos Library can be migrated only once. You can however migrate additional libraries.

1. Open Lightroom CC and select File in the menu bar. In the File menu, select Migrate Apple Photos Library and click Continue.

![Migrate to Lightroom CC dialog box](image)

Click Continue to allow migration of Apple Photos Library to Lightroom CC.

2. You can then view and read the Before You Begin dialog box. Keep the following considerations in mind and click Continue.
   - You can migrate an Apple Photos Library only once.
   - Photos with originals on iCloud and Hidden Photos are not migrated.
   - Ensure that the Apple Photos Library you want to migrate is set as System Photos Library.
Read the details before you begin migration of Apple Photos Library to Lightroom CC.

3 Lightroom CC scans the catalog, launches the migrator, and displays a progress bar of the migration. This step can take a while to complete.

(Occasional) Review any exceptions that the migrator reports. For example, the migrator can report an exception if it is unable to locate some photos included in your source catalog. In such a case, you can click Cancel and begin the process afresh after resolving the issues in Apple Photos Library. If you want to ignore the exceptions and continue migrating, click Start Migration.

Review the information in the Catalog Ready for Migration dialog. If necessary, click Open Log File to inspect details. When ready, click Start Migration.

Lightroom CC begins the migration process and displays a progress bar. Depending on the catalog size and the resources on your computer, this step can take a while to complete.

4 When the migration is complete, a dialog box displays the status. If there are exceptions, click Open Log File to review the details.
Click Open Log File to view the errors in migration. Click Done to complete the migration.

5 Click Done.

Feature summary | Lightroom CC | 2019 releases

The October 2018 releases of Lightroom CC desktop (version 2.0), Lightroom CC for mobile (version 4.0), and Lightroom CC for web (lightroom.adobe.com) roll out several new features and enhancements that enrich your digital imaging experience. Read on for a quick introduction to these features and links to resources offering more information.

Note:
With the new Auto-update feature, your Creative Cloud apps are now automatically upgraded whenever a new version is available. For Lightroom CC, you cannot have two versions of the app running simultaneously on your computer. Your existing app preferences and settings are migrated to the latest version. You can manage the update preferences using the Creative Cloud desktop app. Learn more.

Lightroom CC (desktop)

People view
Powered by Adobe Sensei

Find photos of specific people faster now that Lightroom CC uses Adobe Sensei technology to automatically sort your photos based on who’s in them. When you upload and sync photos to the cloud, Lightroom CC detects, recognizes, and groups photos of the same person.

To navigate to the People View, click the My Photos icon at the upper-left side of the screen and click People.
Migrate Apple Photos (Mac only)

You can now easily migrate your Apple Photos Library into Lightroom CC on your desktop. Your photos sync to the cloud so you can access, edit, organize, and share them on all your devices.

For detailed instructions, see Migrate your Apple Photos Library to Lightroom CC.

Easily share your photos to the web

In addition to sharing albums, you can now share any random selection of photos as a web gallery.

To share a selection of photos, do the following:

1. Select photos that you want to share from the grid view or the filmstrip.
2. Right-click (Win) / Control+click (Mac) over your selection and select Share to Web from the context menu.
3 In the **Share Settings** dialog box that appears, a unique link is generated. You can use this link to share your selected photos. Edit the name of the set of photos being shared under the **Title** option and specify the sharing **Preferences**.

4 Click **Continue**. Your set of selected photos is now public.

To view the list of all photos or photo galleries that are public, click the **Sharing** icon to bring up the **Sharing** panel. Under **Shared to Web**, click **Photos** to find all your public photos and photo galleries as a drop-down list.

For detailed information, see **Share photos as a web gallery**.

**Adobe Portfolio integration**

Showcase your photos on the web now that you can send them directly to Adobe Portfolio from Lightroom on your desktop.

For detailed information, see **Share to Adobe Portfolio**.

**Improved search**

**Powered by Adobe Sensei**

Start typing in the search bar, and Lightroom CC automatically offers suggestions to help you quickly find what you need. Search for cameras, locations, and other metadata with ease. Also, your enabled filters are kept neatly organized in the search box. You can even search for a filter using its name (try 'camera:').
For related information, see Search, filter, and sort photos.

**Local color toning**

You can now apply colors to specific areas of your photo with the Brush and Gradient tools.

When using the Brush, Linear Gradient, or Radial Gradient tools in Lightroom CC, scroll down to the bottom of the adjustment sliders panel to turn on Color.

(Illustrative example) Changing the color of irises (eyes) using the Brush tool.

To learn how to use the Brush and Gradient tools to enhance different parts of a photo, see the following tutorials:

- Make selective edits
- Improve a portrait
HEVC file support on macOS
Beginning with this release, Lightroom CC supports Apple’s HEVC video format (High Efficiency Video Coding, also known as H.265) on macOS High Sierra (10.13) or later.
For more information, see HEVC video files support.

Support for new cameras and lenses
For a full list of supported cameras and lens profiles, see these resources:
- Supported camera models
- Supported lens profiles

Lightroom CC for mobile (iOS and Android)

People view
Quickly find the people you care about with the Adobe Sensei-powered People View. Lightroom CC automatically tags people in photos and provides you with an easy way to see all of the photos that person appears in.

People view in Lightroom mobile for iOS recognizes and groups photos of the same person in a cluster.
People view in Lightroom mobile for Android recognizes and groups photos of the same person in a cluster.

For more details, see these Help resources:

- People view (iOS)
- People view (Android)

**Search Improvements**

Now search suggestions are presented as you start typing in the Search bar, recommending things like cameras, lenses, shutter speeds, apertures, ISOs, keywords, locations, and more.
Intuitive autocomplete suggestions when using Search in Lightroom CC for mobile (iOS)

Intuitive autocomplete suggestions when using Search in Lightroom CC for mobile (Android)
For more details, see these Help resources:

- Search photos (iOS)
- Search photos (Android)

**Additional sharing options for Share to Web**

You can now choose to only share images that are flagged or with a certain star rating or higher, while controlling the display theme and appearance, directly from within Lightroom CC app.

Display options when you share your collection on web in Lightroom CC for mobile (iOS)
Display options when you share your collection on web in Lightroom CC for mobile (Android)

For more details, see these Help resources:

- Share web gallery (iOS)
- Share web albums (Android)

**New guided tutorials**
The following new guided tutorials have been introduced in this release:

- (iOS) First-Time Adjustments and Healing Brush
- (Android) First-Time Adjustments, Target Adjustment Tool, and Guided Upright
New guided tutorials under Help & Support in Lightroom CC for mobile (iOS)
Support for new cameras and lenses
For a full list of supported cameras and lens profiles, see these resources:

- Supported camera models
- Supported lens profiles

Other enhancements
- Improved high-ISO rendering: Raw processing has been further improved to render low-light, high-ISO shots with more natural color.
- (Android only) Improved quality of HDR captures.

Lightroom CC for web (lightroom.adobe.com)
The new Display view within lightroom.adobe.com lets you see a preview of the page, exactly how your viewers will see it. While in the Display view, you can control the layout and background color while inserting breaks between images and text to help tell the story that accompanies your photos. When you’re done setting up the layout, you can then share the album using the controls under Sharing.
Find and organize photos of people in the People View

When you upload and sync photos to the cloud, Lightroom CC detects, recognizes, and groups photos of the same person. You can access these photos in the People View and easily browse the photos of a particular person.

View people in your photos

1. In My Photos panel at the upper-left side of the screen, select People to view the People View.
   
   In this view, you can access People clusters where each cluster contains photos of a particular person. The total number of photos for each person is listed below the cover photo of the cluster.

   **Note:**

   **When I access the People View, why does Lightroom CC display 'No People Found Yet'?**

   Initial indexing of your photos may take some time. The 'No People Found Yet' message is displayed when Lightroom is still analyzing all your photos to find people or when there aren't any people in your photos.

2. Click any cluster to view photos of that person. You can also view the total number of photos in the cluster at the upper-right corner of the screen.

Sort options in People View

You can use the following options to sort People clusters in the People View:

- **Count** (Number of photos in a cluster)
To sort People clusters, follow these steps:

1. In the My Photos panel at the upper-left side of the screen, select People to view the People View.
2. Click the three dots icon in the upper-right corner of the screen. In the drop-down list, under Sort By, select one of the following options:
   - Name: Sorts named clusters in alphabetical order.
   - Count: Sorts clusters in order of the highest number of photos to the least number of photos in a cluster.

You can sort People by name or count.

**Name or rename People**

- Name a Person
- Rename a Person
- Add names to a photo in the Keywords panel

**Name a Person**

1. In the People View, click the unnamed cluster. The cluster opens.
2. In the open cluster, enter the person’s name in the Add Name field at the top of the cluster.
3. Press Enter or click outside the Add Name field.

   *Note:*

   Alternatively, you can Ctrl-click (Mac)/right-click (Win) a person’s cluster and select Add Name to name a person.

**Add names to a photo in the Keywords panel**

To add a photo to a People cluster, follow these steps:

1. Select the desired photo from the grid or Filmstrip.
2. In the panel at the right side of the screen, click Keywords to view the Keywords panel.
3. Under People in the Keywords panel, you can add the person’s name in the Add Name field. Press Enter or click outside the name field to set the name.
**Rename a Person**

You can rename a People cluster in one of the following ways:

- In the People View, Control-click (Mac) or right-click (Win) a People cluster and select **Rename Person**. You can edit the person’s name and then press Enter or click outside the name field to set the name.

- Click a People cluster in the People View. Within the open cluster, you can do one of the following:
  - Directly edit the name at the top of the cluster. Once you’ve edited the name, press Enter or click outside the name field.
  - Click the three dots icon in the upper-right corner of the screen and select **Rename Person**. You can then edit the name at the top of the cluster. Press Enter or click outside the name field to set the name.

**Show or hide People**

1. In the **My Photos** panel at the upper-left side of the screen, select **People** to view the People View.
2. In the People View, click the three dots icon in the upper-right corner of the screen and select **Show and Hide People**.
3. People clusters that are shown in the People View are selected by default. To show a cluster that is hidden, select it. To hide a cluster, deselect it.
4. Click **Done**.

**Merge People**

1. In the **My Photos** panel at the upper-left side of the screen, select **People** to view the People View.
2. In the People View, do one of the following:
   - Select the clusters that you want to merge (Command-click in Mac/Shift-click in Win) and click **Merge** in the top panel of the screen.
   - Rename a cluster to the desired person’s name and click **Merge** in the dialog box that appears.
   - Drag-and-drop a cluster to another cluster. In the **Are these the same person?** dialog box that appears, select **Merge**.

*Note:*

*Lightroom CC can detect when two clusters might actually be the same person. In this case, when you view one of the clusters, you’ll see a banner at the top which suggests merging the two clusters. Click **Yes, Merge** to merge the clusters or **No** to not merge the clusters. If you click **No**, Lightroom will not suggest merging those two specific clusters again. If you want to simply dismiss the suggestion banner without doing anything, click the X icon in the upper-right corner of the banner.*

**Change a person’s cover photo**

1. In the **My Photos** panel at the upper-left side of the screen, select **People** to view the People View.
2. Click a desired People cluster. In the open cluster, select a desired photo.

*Note:*

*Only the person in the selected photo is set as the cover photo even if the photo has other people.*

3. Click in the upper-right corner of the screen, and select **Set as Cover Photo**. Alternatively, you can right-click the photo and select **Set as Cover Photo**.
Remove a photo from a person's cluster

You can remove any photo from a People cluster in one of the following ways:

- From within a People cluster
- From the Keywords panel

**From within a People cluster**

1. In the **My Photos** panel at the upper-left side of the screen, select **People** to view the People View.
2. Click a desired People cluster. In the open cluster, select a desired photo.
3. Click ![ People icon ] in the upper-right corner of the screen, and select **Remove Photo from Person**.
4. In the **Remove Photo from Person** dialog box that appears, click **Remove**.

   **Note:**
   Alternatively, you can do one of the following:
   - Control-click (in Mac)/right-click (in Win) a photo in an open cluster and select **Remove Photo from Person**.
   - Control-click (in Mac)/right-click (in Win) a photo in an open cluster and select **Move To**. You can then select a person's name to move the photo from the open cluster to another cluster.

**From the Keywords panel**

1. Double-click a desired photo from the grid or Filmstrip to open it.
2. In the panel at the right side of the screen, click **Keywords** to view the **Keywords** panel.
3. In the **Keywords** panel, hover over the person's name and click the cancel icon.
4. In the **Remove Photo from Person** dialog box that appears, click **Remove** to remove the photo from the person's cluster.